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Std Xl Science/Commerce 2010-11
Past Term End Papers

STATISTICS -1

A Question numbers 1 to 5 carry 1 mark each [5]

1. When any authorized organization or investigator collects the data for the first
time himself it is called

2. When the variable characteristics associated with a sample is qualitative, the
characteristics is called

3. Class length = -

4. In order to draw a circle diagram we take the of the volume of data
expressed in number for each unit as the radius of the circle.

5. The mean of 5 observations is 62.5. If 5 is added to each observation and the
result is divided by 2, the new mean is

B Question numbers 6 to 11 carry 1 mark each [6]

6. State two limitations of the method of indirect inquiry.

7. Give two points of difference between discrete and continuous frequency
distribution.

8. What is manifold classification ?

9. Which type of graph is best suited to represent statistics regarding production and
sales, birth rates and death rates?

10. State two characteristics of an ideal measure of central tendency?

11. If the mean of the observation is calculated to be 13, taking the assumed mean as
13, then the sum of the deviations from assumed mean is

C. Question numbers 12 to 16 carry 2 marks each [10]

12. Write a short note on population inquiry.

13. Prepare an original frequency distribution from the following cumulative
frequency distribution.
Morethan 25 30 35 40 45 50 55 60 65
c.f. 100 96 87 70 45 25 14 6 1

14. The mean of the observation xi, X», X3, X4, 8, 7, 6, 4, 3, 2, is 7. If the mean of x;,
X5, X3 and X4 18 m, find the value of m.

15. Find the mean of the following distribution by the method of cumulative
frequency. 10, 12, 13, 15

16. You are a member of an NGO and you are conducting a survey regarding the
extent of awareness of aids in the city. Frame four questions you would like to
in your questionnaire for this purpose.

D. Question numbers 17 to 21 carry 3 marks each. [15]
17. Write a short note on Importance of graphs and diagrams.

18. The daily consumption of cotton by textile mills of a city are shown in the form
of frequency distribution as follows. Find the daily consumption of cotton in
bushels per mill.

consumption of cotton 1 2 3-15  15-25  25-35  35-55
(in 1000 bushels)
No. of mills 10 8 18 12 40 12

19. Explain the sources of secondary data.

20. In a sample study about the study habits in two towns- Agra and Jaipur, following
data were observed.
Agra 52% were males
25% were coffee drinkers
16% male coffee drinkers
Jaipur 55% were males
28% were coffee drinkers
18% were male coffee drinkers.
Tabulate the above observations.
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21. Draw the histogram of the following frequency distribution.

Class 0-5 5-15 1530  30-50 50-60
Frequency 8 24 42 32 8
E. Question number 22 carries 4 marks [4]

22. The following data give the annual expenditure (in Rs) on different categories of
two families A and B. Draw the pie diagram for the data.

Expenditure (in Rs)
Category Family A Family B
Food 40,000 50,000
Rent 25,000 30,000
Clothing 10,000 20,000
Education 10,000 32,000
Savings 5,000 28,000
Total 90,000 1,60,000
F. Question numbers 23 and 24 carry 5 marks each [10]

23. In a survey of 24 employees of a municipal transport service relating to their age
(in years) and daily pocket expense (in Rs) the following bivariate data are
obtained. Prepare a bivariate frequency distribution of the data.

Age 26 53 42 37 33 29 48 52 37 41 56 32 50 54 40 48
Expense 40 20 10 30 20 40 20 10 30 40 20 30 20 10 30 10
Age 27 46 42 26 28 40 44 50

Expense 40 30 30 50 40 30 20 20

24. The mean of the following frequency distribution of 125 observations is 22.12.
Find the missing frequencies.
Class 04 59 10-14 15-19 20-24 25-29 30-34 35-39 40-44
Freq 3 8 12 ? 35 21 ? 6 2
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STATISTICS - 11
SECTION A
A Question numbers 1 to 10 are multiple choice questions carrying 1 mark
each. [10]

1. If the total number of random number of size 2 drawn from a population of N
units without replacement is 45 then, find the size of the population.

a. 45 b. 15 c. 12 d. 10
2. For two perfectly correlated variable by, = 5, hence by, = .
a. 0.2 b. -0.2 c. 5 d 1

3. Ifr=-1, then which equation will be shown for finding the unknown variable x
when the value of the variable y is given ?
a.a+tbx (a>0) b.a+tbx (a<0) c.a+bx (a=0) d a+bx

4. Uand ¢ are events of each other.
a. Complementary b. Primary c. Exhaustive d. Independent
5. Which type of population are ‘the students of graduate level of Gujarat

University’?
a. Hypothetical b. Real c. Finite d. Infinite

6. If the increase in production of an item for the year 2002 is 13/4 times that of the
base year. Find the index number for the year 2002.

a. 325 b. 425 c. 525 d. 625
7. In which method of index number does the base year change every year ?
a. Chain base method b. Fishers’ index number
c. Total expenditure method d. Fixed base method
8. If A & B are two independent events and P (A) = 1/3 , P (B) = 3/5, then
P(AUB)=

a. 1/5 b. -2/5 c. 11/15 d/ 3/15
9. Who developed least square method for regression line ?

a. Karl Pearson b. Charles Spearman  c¢. Francis Galton d. C. F. Gauss
10. Give the interval of coefficient of determination.

a. -1<R*<1 b. -1<R*<0 c. I>R*>0 d 1>R*>0
SECTION B
B Question numbers 11 to 20 carry 1 mark each [10]

11. What is explicit weight ?

12. Why is index number called the barometer of the economic activity of a country ?

13. What is sample estimation ?

14. If A and B are mutually exclusive and exhaustive events, find P(AUB) &
P(AnB).

15. State the limitation of scatter diagram.

16. When is rank correlation useful ?

17. State the parameters of a population data.

18. Define an event.

19. Define regression coefficient.

20. What is the assumption taken into consideration in the study of regression ?

SECTIONC

C Question numbers 21 to 32 carry 2 marks each [24]

21. The prices of 5 items have changed to 50% , 80% , 110% , 160% & 200%
respectively. If the weights of these items are in the proportion of 10:6:4:3:2,
find the common Price Index Number.

22. For an item Zpqo : Zpoqo =35 :4and Z pi1q1 = X poqo=8: 5, then find I, Ip
and Ip.

23. State the points to be considered while determining the size of the sample.

24. Select a random sample of size 6 1) with replacement 2) without replacement
using the following 10 random numbers. 120, 50, 288, 720, 120, 325, 227, 667,
195, 347.

25. If X=169cm, Y =67 kg, Sx =20 cms, Sy =3 kg and r = 0.5, then find the
regression lineof X on'Y .

26. Explain with reasons wether the following statements are true or false.

a. byx=0.05 by=24
b. bx=12 by =2.1
C. bx=-04 by, =1

Page 3 of 56



NAVRACHANA VIDYANI VIDYALAYA SAMPLE PAPERS 2010-11

217.

28.

28.

29.
30.
31.
32.

34.

35.

36.

37.

38.

39.

40.

d. by=0 byy =1
Let A be any event in a sample space of a random experiment. For the
complementary event A’ prove that P (A’ )=1-P(A)
IfP(A)=0.6,P(B)=0.7and P (AU B)=0.9, find the probability of
difference events A—Band B— A .
OR

Write the events A; U A, and A; N A; if the two events A; and A, of a random
experiment are described as given below.

I. Aj={x:0<x<5},A={x:-1<x<3,xisan integer }

2. Aj= {x:x=0,1,2...... 10}, Ay={x:2<x<3}
Ifr=08,2(x-x)(y—-y)=60,S,=25 ,2 (x—x)*=90. Find n.
Write the characteristics of correlation coefficient.
Find the probability of 53 Sundays in a leap year.

Information obtained from 16 sample observations of two random variables X
and Y is as follows. Z=x=0,Zy=736,Zx* =80, 2 y*= 36299 , = xy = 313
Find the value of r ( x,y )

SECTION D
Question numbers 33 to 40 carry 3 marks each [24]

. Convert the following chain base index numbers of production of a manufacturing
industry of a state, into fixed base index numbers taking 2003 as the base year.
Year 2003 2004 2005 2006 2007 2008
Chain base index no. 100 120 160 140 130 150
Find the index number for the year 2004 by family budget method from the data

of prices and quantity of food items given as under.
Item 1996 2004

Qty (inkg)  Price (in Rs.) Price (in Rs)
Wheat 60 5 10
Rice 40 6 18
Bajri 15 4 6
Tuver dal 25 10 30

A population of units is divided into two strata of sizes N; =20 & N, = 30
respectively. The observation on the units of a random sample drawn from the first
stratum are 20 , 30, 50 and 22 and those on the units of a random sample from the
second stratum are 100, 104, 105, 110, 111. Using the sample data, find an
estimate of the population mean.

A random sample of n = 20 observation from a population of 400 observations
gave the following information. Find the estimate of the total of population
observation and its estimated standard deviation.

Yyi=760,% (yi—y)=7,600

A box contains 4 red , 3 white and 3 black balls.

1. A ball is drawn at random from the box. Find the probability that the ball

draw is white.
2. Two balls are drawn at random from the box. Find the probability that the balls
drawn are of same colour.
3.Three balls are drawn at random form the box. Find the probability that there is
one ball of each colour.

4 couples ( husband and wife ) attend a party. Two individuals are selected at
random from these four couples. Find the probability that the two selected
individuals are,

1. husband and wife

2. aman and a woman

3. aman and a woman but they are not husband and wife

Two judges assign the following ranks to 8 candidates in an elocution
competition.Find the rank correlation coefficient between the evaluations

of 2 judges.

Sr. no. of candidates 1 2 3 4 5 6 7 8
Rank by judge 1 4 2 7 1 3 8 6 5
Rank by judge 2 7 1 6 3 2 8 5 4
Forztwo variables X and Y where u=(x—-45)and v=(y—110), find by, byy
&r

n=10,%u=6, Sv=7,3u’ =40, Iv*=25, Zuv =30
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SECTION E
E Question numbers 41 to 43 carry 4 marks each. [12]
41. A transport company dealing with transport goods conducts a sample survey to
study the relationship between time of usage of vehicle (truck) and cost of
maintenance incurred on them. The data collected from the inquiry are given in
the following table.

Time of usage of vehicles 5 3 3 2 1 2
(in years )
Annual cost of maintenance 13 10 8 7 5 8

(in 10,000 Rs.)
1. Draw a scatter diagram of the data and the regression line of Y on X
2.If the actual regression line of Y on X is ¥ = 3.35 + 1.93 x then estimate the
value of y when x =4
42. State with reasons whether the following statements are true or false.

1. In computations of rank correlation coefficient if ©d* = 0 then the rank
correlation coefficient is perfect and negative.

2. If the correlation coefficient between two variables is zero then there is no
relation between them.

3. If the correlation between X and Y is r = %, the correlation coefficient between
2Xand Yis 1.

4. If 10 observations on two variables X and Y are the permutations of the integers
{1,2,3,....... ,10 }then Karl Pearson’s correlation coefficient and Spearman’s
rank correlation coefficient are equal.

43. a. Write the law of addition of probability of two events
1. when the events are exclusive
2. when the events are not exclusive
b. Write the law of multiplication of probability of two events
1. when the events are independent
2. when the events are not independent

SECTION F
F Question numbers from 44 to 48 carry 5 marks each. [20]
44, Find IL . Ip & IF
Item 2005 2003
Price Expenditure  Expenditure Price

A 8 160 50 5

B 22 110 60 20

C 15 150 80 10

D 50 1,500 500 25

E 300 1,800 1,000 200

45. Calculate correlation coefficient between income and expenditure
Income 5,000 6,500 6,800 7,000 7,100 7,300 7,500 8,000
Expenditure 4,000 5,500 6,000 6,000 6,500 7,000 7,000 7,500
46. The data on age and weight of children randomly selected from parcticipating in a
race ate given below. Fit the regression line of X on Y and find the value of and
compute the coefficient of determination and verify whether the assumption of
linearity of regression between the age and weight of children is appropriate or
not.
Age (in years) 8 6 8 5 7 6 9 7
Weight (in kg) 20 16 18 14 14 10 15 15
47. A random sample of 1000 families is drawn from a population of 10000 families
of a city. The sample inquiry of families about the number of children yielded the
following result
No. of children 0 1 2 3 4 5
No. of families 510 230 160 60 30 10
From the sample data find the estimate of the total number of children in the city
and estimate its standard deviation.
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STATISTICS - 111
SECTION A
Question numbers 1 to 10 carry 1 mark each
1. index Number is used to determine the pay scale, dearness allowance, bonus
of the employees.
a. wholesale index number b. industrial production index number
c. employment index number d. cost of living index number
2. Which is the scientific method of selecting simple random sample?
a. rank method b. lottery method
c. method of random numbers d. first come first serve method
3. If r = 0.2, what will be r between — 2x and 4y.
a. 0.2 b. —0.2 c. 04 d. 0.8
4. The correlation coefficient is mean of regression coefficient.

a. arithmetic mean b. simple average c. harmonic mean d. geometric mean
5. Which of the following result is true in case of probability of two mutually exclusive
but not exhaustive events A and B.
a. P(AuB)=0 b.P(AnB)=0 c¢. P(AnB)=1 d P(AuB)=1
6. What is the standard deviation of a binomial probability distribution?
a. npq b. np c. (npq)’ d. \npq
7. What is the area of the region under normal curve bound by vertical lines p £338?
a. 0.6826 b. 0.9500 c. 0.9545 d. 0.9973
8. Write the other name of trend.

a. long term fluctuatins b. seasonal fluctuations
c. cyclical fluctuation d. random fluctuations
9. The n" term of a geometric progression ar, ar” ar- ....... is
a. ar” b. ar" c. ar” d a[r"—1]
r—1
10.Ay, means .
a.y — Yo b. yo—y1 ¢ yi—Yo d. y2-yi
SECTION B

Question numbers 11 to 20 carry 1 mark each.

11. State the methods of assigning explicit weight.

12. Which tables of random numbers are most commonly used? When were they

prepared?

13. Give two examples of variables, between which there exist a negative correlation?

14. The regression lines of Y on X and X on Y obtained from a bivariate data are
y=58+0.08x and x=-99 + 2.5y respectively. Find the correlation coefficient
between x and y.

15. Arrange the probabilities P (A),P(AUB),P(ANnB),P(A)+P(B)in
decreasing order of magnitude.

16. If p <4 , state the type of skewness.

17.1fP(Z <1+ C)=0.5, find the value of constant C.

18. Write the equation of finding the value of ‘a’ and ‘b’ by least square method of time
series.

19. For a geometric progression T12 =T, and Tz =27 find T,

20. State the Newton’s formula of linear interpolation.

SECTIONC
Question numbers 21 to 32 carry 2 marks each
21. The price of an item in the year 2005 has increased to Rs. 1140 from the price of
Rs. 570 in 2000. Find the price index of the item and point out the percentage
increase or decrease in the price of the item.
22. State the characteristics of a good sample.
23. Sx=2.50,S,=20,r=0.60 Find the covariance
24. State the properties of regression coefficient.
25. A box contains 3 coins each of Re 1, Rs 2 and Rs 5. Write the sample space of the
experiment of drawing two coins from the box.
26. A and B are independent events and P (A )=0.32, P (B ) =0.75.
Find (i) P(AuB) (i) P(A’nB’)
OR
26. If three coins are thrown simultaneously, find the probability of getting two heads
and one tail.
27. For a binomial distribution with n =3 and p = 0.4, it is given that P ( 0 ) = 0.216.
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Using recurrence formula for the binomial distribution, find P (1) & P (2).

28. Two slips are drawn at random from 5 different slips numbered 1 to 5. Find the
probability distribution of the sum obtained on the two slips.

29. Mr. A plays a game and his probability to win the game is 0.6. Find the probability
that he wins 2 games out of 3 games. OR

29. State the properties of a binomial distribution.

30. Write the probability density function of a normal distribution with notations.

31. The following information is available on the variable quantity y; of the time series
for the first 9 months.
n=9,%y =118, 2t =285, Sty, = 710.4
Fit the trend line to the time series data.

32. For geometric progression it is given that S, =1.24 ,a=1andr=0.2. Findn .

SECTION D
Question numbers 33 to 40 carry 3 marks each.
33. Exports ( in lakh Rs))

Item 1998 1999 2000 2001
A 20 23 25 32
B 10 15 18 27
C 25 32 40 56

Compute general index number for export from the data by fixed base method
taking 1998 as the base year.

34. The results of a sample inquiry are given below
Stratum  Stratum size  Sample size  Sample mean  Sample variance

A 150 15 240 144
B 250 25 280 81
Find an estimate of population mean and its estimated variance.

35. Obtain an estimate of population total and estimated variance of the estimate of
population total from the following data collected by a sample inquiry.
N=1500, n=200, y=500, X(yi—y)>=39800

36. Find the rank correlation coefficient

X 15 2.5 0.5 2.0 1.5 2.0 1.0
Y 3 5 2 5 4 6 6
37. Explain the meaning of regression with its uses.
OR

37. Recognise the independent and the dependent variable from the following pairs

consumption of electricity and its bill

. number of vehicles and number of accidents

use of fertilizers and yield of crops

. price of milk and price of tea

consumption and price
f. sales and profit

38. IfP(A)=1/3,P(B)=%andP(AUB)=11/12.Find P (A/B)and P ( B/A)

39. There are 2 white and 3 red balls in one box and 2 red and 4 black balls in another
box. A box is selected at random and a ball is drawn at random from it. Find the
probability that the ball drawn is red.

40. State the assumption underlying the theory of interpolation and extrapolation.

o a0 o

SECTION E

Question numbers 41 to 43 carry 4 marks each

41. The mean and standard deviation of a normal distribution are 12 and 3 respectively
Find the range of 60% of the observation located in the middle of the distribution.

OR

41. The marks obtained by 10000 students who appeared in a talent search test of 70
marks are normally distributed with mean and standard deviation 30 and 10 marks
respectively. Find the estimated number of students who get less than 25 marks. If
students who get more than 45 marks are to be awarded scholarship for higher
studies, find the number of students who will get scholarship.

42. The sale yt (in ‘000 Rs.) in a readymade garment store for the day of the week
is as follows
yt=125,t=1,3,5,7
yt=200, t=2,4,6
Fit the linear trend line to the data .

43. A sum of Rs. 150 is to be distributed among 4 persons A, B, C and D in such a way
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that the amounts received by them are in geometric progression. Person A receives
the least amount and D gets the most. If the sum of the amount receive by A and D
is 90 find the amount received by B.
OR
43. Find the maximum value of n such that the sum S, of the first n natural numbers
of G.P 2, 4, 8, 16 does not exceed 4094.

SECTION F
Question numbers 44 to 47 carry 5 marks each
44. Find the index number for the group from the following

Item Price Quantity
2004 2007 2004
Wheat 1.5 2.1 15
Rice 1.9 2.6 5
Bajra 2.0 2.8 5
Dal 2.0 4.0 4
Oil 3.5 4.9 3
Sugar 8.0 10.0 2

45. Find Karl Pearsons coefficient of correlation.
Price 171 185 195 201 212 212 230 241 253 256
Stock 207 225 228 231 232 236 252 269 258 258
46. Obtain the regression line of y on x and estimate y if x = 3, also at this time find the
error of approximation.
X 5 4 3 2 1 2
Y 13 10 8 7 5 8
47. The information regarding the price per kg and the quantity of supply of an item is
given in the following table. Find the unknown quantity of supply by the method of
Binomial Expansion.

Price per kg (in Rs.) 10 15 20 25 30 35
Quantity of supply (in ‘000kg ) 2 5 . 20 30 32
OR

47. From the data given below obtain the estimate of y for x =2 and x = 4 by
Langrange’s method.
X 0 1 3
Y 5 9 35
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ECONOMICS-I

A Question numbers 1 to 10 are multiple choices questions carrying 1 mark
each [10]

1. The knowledge of which of the following subjects is useful to understand the
analysis of economics.
a. chemistry b. physics c. geometry d. history

2. Who presented the physical quality of life index ?

a. Davis Morris b. United Nations Development Program
c. Marshall d. Pascal and Fermet
3. With what income less than given below, a country is called a developing country?
a. 735§ b. 375§ c.745 % d. 537 %
4. When was the RBI established?
a. 1955 b. 1935 c. 1953 d. 1945
5. In India the first oil fields were found in
a. Gujarat b. Maharashtra c¢. Assam d. Bihar
6. The transportation of gas is taken care by the .
a. Airport Authority of India b. Gas Authority of India
c. Indian Oil Corporation d. Bothbandc
7. What was the percentage rate of inflation during the planning period in total?
a. 4to05 b. 7t09 c. 6to7 d. 8to 9
8. When was the first planning commission created?
a. 1947 b. 1952 c. 1950 d. 1951

9. What are economic decisions based on market systems known as?
a. globalization b. liberalization c. privatization d. disinvestment

10.To what extend the total population of India increased during the decade 1901 to
1951 A D?
a. one b. one and half  c. three d. three and half

B Question numbers 11 to 20 carry 1 mark each [10]
11. Give the full form of CSO.

12. How are graphs and figures useful in economics ?

13. The contribution of which sector decreases with economic development?
14. Where and when did the industrial revolution take place?

15. By whom are the ports of India managed?

16. What is meant by a capitalist economy?

17. What do you mean by money order economy?

18. Why did India have to undertake economic reforms in 1991?

19. Why has populations been termed as the ‘black night enemy’?

20. Why has the year 1921 termed as the year of great divide?

C Question numbers 21 to 34 carry 2 marks each [28]

21. What is comparative study? Explain its types.

22. What is the importance of statistical data in deciding the size of economics event?
23. ‘Rich India is inhabited by poor people’. Explain this statement.

24. Though India is an agricultural country its contribution towards the national
income is less. Explain.

25. What is Green Revolution . Explain

26. What is included in the secondary sector in the occupational structure?

27. What is infrastructure? State the types of infrastructure.

28. How much percentage of National Income is spent on education? At what level of
education more money is spent?

29. What is the difference between self dependence and self reliance?

30 Why did India select to adopt economic planning after independence?

31 Explain the main objectives of privatization in India

32. What were the restriction imposed on the private sector before the introduction of
economic reforms 19917

33. Explain the stages of demographic transition.

34. State the objectives of population policy framed under Dr. M. S. Swaminathan.

D Question numbers 35 to 43 carry 3 marks each [27]

35. What are the points to be remembered while presenting the statistical data
through graphs and diagrams ?
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36.

37.
38.

39.
40.
41.
42.
43.

Explain the Human Development Index as an indicator of economic
development.

Explain ‘Agricultural sector before independence.’

Explain the changes that took place in the industrial sector during the
planning period.

Explain the importance of economics infrastructure.

Describe the different modes of communications.

What is globalization? To what extend India was benefited due to this reform?
Explain any 3 limitations of planning.

Explain any three measures of population control.

E Question numbers 44 to 49 carry 5 marks each [25]

44,

45.

46.
47.

48.

Present the following data in collateral bar diagram and analyse it.
Estimate poverty in India (%)

Year Rural Urban
1987-88 39.1% 38.2%
1993-94 37.3% 32.4%
1999-00 27.1% 23.6%

India is a developing country. Explain this statement with reference to
characteristics of a developing country.

What do you mean by planning? Discuss the main objectives of planning?
Explain the meaning of Direct Foreign Capital Investment and evaluate the policy
of Indian Government regarding the Direct Foreign Capital Investment.

Explain the causes of high birth rate in India.
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ECONOMICS-I1I
Question numbers 1 to 10 are multiple choices questions carrying 1 mark
each [10]
1. The knowledge of which of the following subjects is useful to understand the
analysis of economics.
a. chemistry b. physics c. geometry d. history
2. Who presented the physical quality of life index ?

a. Davis Morris b. United Nations Development Programme
c. Marshall d. Pascal and Fermet
3. With what income less than given below, a country is called a developing country?
a. 735 8% b. 375 % c.745 % d. 537§
4. When was the RBI established?
a. 1955 b. 1935 c. 1953 d. 1945
5. In India the first oil fields were found in
a. Gujarat b. Maharashtra c. Assam d. Bihar
6. The transportation of gas is taken care by the .
a. Airport Authority of India b. Gas Authority of India
c. Indian Oil Corporation d. Bothbandc
7. What was the percentage rate of inflation during the planning period in total?
a. 4t05 b. 7t0 9 c. 6to7 d. 8to 9
8. When was the first planning commission created?
a. 1947 b. 1952 c. 1950 d. 1951

9. What are economic decisions based on market systems known as?
a. globalization b. liberalization c. privatization d. disinvestment

10.To what extend the total population of India increased during the decade 1901 to
1951 A D?
a. one b. one and half c. three d. three and half

B Question numbers 11 to 20 carry 1 mark each [10]
11. Give the full form of CSO.

12. How are graphs and figures useful in economics ?

13. The contribution of which sector decreases with economic development?
14. Where and when did the industrial revolution take place?

15. By whom are the ports of India managed?

16. What is meant by a capitalist economy?

17. What do you mean by money order economy?

18. Why did India have to undertake economic reforms in 1991?

19. Why has populations been termed as the ‘black night enemy’?

20. Why has the year 1921 termed as the year of great divide?

C Question numbers 21 to 34 carry 2 marks each [28]

21. What is comparative study? Explain its types.

22. What is the importance of statistical data in deciding the size of economics event?

23. ‘Rich India is inhabited by poor people’. Explain this statement.

24. Though India is an agricultural country its contribution towards the national
income is less. Explain.

25. What is Green Revolution . Explain

26. What is included in the secondary sector in the occupational structure?

27. What is infrastructure? State the types of infrastructure.

28. How much percentage of National Income is spent on education? At what level of
education more money is spent?

29. What is the difference between self dependence and self reliance?

30 Why did India select to adopt economic planning after independence?

31 Explain the main objectives of privatization in India

32. What were the restriction imposed on the private sector before the introduction of
economic reforms 19917

33. Explain the stages of demographic transition.

34. State the objectives of population policy framed under Dr. M. S. Swaminathan.

D Question numbers 35 to 43 carry 3 marks each [27]

35. What are the points to be remembered while presenting the statistical data
through graphs and diagrams ?

36. Explain the Human Development Index as an indicator of economic
development.
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37.
38.

39.
40.
41.
42.
43.

Explain ‘Agricultural sector before independence.’

Explain the changes that took place in the industrial sector during the
planning period.

Explain the importance of economics infrastructure.

Describe the different modes of communications.

What is globalization? To what extend India was benefited due to this reform?
Explain any 3 limitations of planning.

Explain any three measures of population control.

E Question numbers 44 to 49 carry 5 marks each [25]

44,

45.

46.
47.

48.

Present the following data in collateral bar diagram and analyse it.
Estimate poverty in India (%)

Year Rural Urban
1987-88 39.1% 38.2%
1993-94 37.3% 32.4%
1999-00 27.1% 23.6%

India is a developing country. Explain this statement with reference to
characteristics of a developing country.

What do you mean by planning? Discuss the main objectives of planning?
Explain the meaning of Direct Foreign Capital Investment and evaluate the policy
of Indian Government regarding the Direct Foreign Capital Investment.

Explain the causes of high birth rate in India.

Page 12 of 56



NAVRACHANA VIDYANI VIDYALAYA SAMPLE PAPERS 2010-11

ECONOMICS-11I
SECTION A
A. Question numbers 1 to 10 are multiple choice questions carrying 1 mark each. [10]
1. Which of the following sciences is Economics ?
a) monetary b) social c¢) physical d) modern

2. In which indicator of Economic development is per capita income, knowledge and health
included ?
a) national income b) per capita income
c) physical quality of life index d) human development index
3. What is the most essential requirement for human development.
a) primary education b) higher education c¢) secondary education d) literacy
4. What are economic decisions based on market systems known ?
a) Globalisation b) liberalisation c¢) privatization d) disinvestment
5. What was the population growth rate in India in 2001 ?
a) 2.1% b) 1.9% c) 1.8% d) 1.6%
6. Which type of unemployment is mainly found in developed countries ?
a) disguised b) seasonal c¢) educated d) cyclical
7. In which of the following countries given below urban population is around 70% to 75% .
a) India b) China c) USA d) Indonesia
8. Farmers having 4 to 10 hectares of land are classified as farmers.
a) marginal b) small ¢) medium d) big
9. Working population means population in the age group ......
a) 12—-45years b) 15— 60 years c) 15—45 years d) 25— 50 years
10. In which city was the first global meet for environmental problem held ?
a) Rio-De-Janero b) Stockholm c¢) Johanesberg  d) New York

SECTION B
B. Question numbers 11 to 20 carry 1 mark each [10]
11. What are the hurdles in the development of waterways.
12. What do you mean by buffer stock ?
13. Explain the importance of infrastructure in the development of agricultural sector.
14. Why is it not possible to utilize the non traditional source of energy fully.
15. At present which five year plan is in operation in India ? What growth in national income is
aimed at ?
16. Which subject helps in analysis of data related to economics ?
17. Which year is called the year of great divide ?
18. In 1947, what was the share of industries in employment and national income in India ?
19. What is industrial unemployment ?
20. State two push base factors of urbanization ?

SECTIONC
C. Question number 21 to 34 carry 2 marks each [28]
21. What is the difference between economic growth and economic development ?
22. After the economic reforms, how many units are left with the public sector? Which are they?
23. National income is not considered to be an accurate measure for economic development.
Explain.
24. What is outward looking policy ? Explain
25. Explain the stage of population explosion.
26. What do you understand by Green National Income ? Explain.
27. Explain two main factors for urbanization in India.
28. Why has the problem of educated unemployment increased in India ?
29. The marginal farmers of India are “born in debt, live in debt and die in debt.” Explain this
statement.
30. Give two points of difference between Institutional changes and Technological changes.
31. There is inequality in the distribution of income in India. Explain.
32. What is Green Revolution ? In which main crops green revolution was seen in India ?
33. What is included in the qualitative changes in the industrial sector ?
34. What are the main forms of telecommunication ?

SECTION D
D. Question numbers 35 to 43 carry 3 marks each [27]
35. Explain : The evaluation of effects of economic reforms in India.
36. What is the situation of social infrastructure in our country since independence.
37. What are the problems faced by large and medium scale industries in India.
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38.
39.
40.

41.
42.
43.

44,
45.
46.
47.
48.

What is the importance of statistical data in relation to economic problems ?

Describe the general measures to reduce unemployment.

“The effects of population increase on savings, the form of investment and environment
are controversial.” Discuss the statement

Give the difference between absolute poverty and relative poverty.

Explain human development post independence era.

What is privatization ? Explain with examples.

SECTION E
Question numbers 44 to 48 carry 5 marks each.
Define planning. Give the limitation of planning in India.
Urbanisation policy are the two sides of the same coin. Explain
Industrialisation is important for economic development. Explain.
Explain the main components of environment policy.
Present the following information regarding the percentage of poverty in the rural and urban
areas in India in a diagram and analyse it.

Year Rural area Urban area
1973-74 56.4 49.0
1987-88 39.1 38.2
1993-94 37.3 324
1999-00 27.1 23.6
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ECONOMICS-1V
SECTION A
Question numbers 1 to 10 carry 1 mark each [10]
1. For national income growth rate, which graph/diagram is more convenient ?
a) bar graph b) cluster bar graph ¢) pie diagram d) subdivided bar graph
2. A country whose PCI is high but its distribution is unequal is .

a) Italy b) Nigeria c) Argentina d) Myanmar
3. What is the generation of electricity by coal known as ?
a) thermal electricity b) hydro electricity
c¢) nuclear electricity d) wind electricity
4. India’s share in the world agriculture export in 1999 was
a) 3.1% b) 2.5% c) 1.9% d) 2.3%
5. Who presented the concept of physical quality of life index ?
a) Arthur Louis b) United Nations Development Programme
¢) Adam Smith d) Davis Morris
6. How many sectors were reserved for the public sector according to 1991 ?
a) 3 b) 4 c) 5 d) 6

7. According to Demographic Transition theory , in which stage population explosion takes
place ?
a) first b) second ¢) third d) fourth
8. From the following which unemployment is known as open or full unemployment ?
a) daily status b) weekly status c) usual status  d) cyclical
9. Due to migration the level of environment pollution .
a) increases  b) decreases c) does not change d) none of the above
10. Which period of agriculture development is known as Green Revolution ?
a) before 1951 b) after 1968 c) before 1968 d) after 1991

SECTION B
Question number 11 to 20 carry 1 mark each [10]
11. What is shown on the Y axis of a graph?
12. What is meant by birth rate?
13. What is the definition of sustainable development given by UNESCO?
14. Which public sector manages the entire telephone services in India? Since which year?
15. Define planning.
16. What is family planning?
17. Through which scheme training was given to rural youth for self employment?
18. In the urbanization policy of the government of India, which committee has provided
suggestions ?
19. Explain the term productivity of land.
20. When did the Bhoodan movement start?

SECTIONC

Question number 21 to 30 carry 2 marks each [28]

21. Indian economy possesses the characteristics of both modernity and traditional. Explain.

22. What are the direct and indirect steps taken by the government for industrial
development.

23. Health services can be considered as the pre-requisite for economic development.
Explain.

24. Explain airways as a mode of transportation.

25. Why did privatization take place at a slower pace and why was it not successful?

26. Poor families in India consider children as an asset not a liability. Give reason.

27. State the progress of India for the objective of self reliance.

28. What is environment sink?

29. Explain the statement ‘there is a definite relationship between economic development and
environment.’

30. What is the ratio of female per 1000 male in 2001 in India and Gujarat?

31. Give the meaning of a city.

32. Explain organized and unorganized sector in agricultural credit market.

33. What is agricultural extention and intensive agriculture.

34. What is meant by industrial sickness and industrial disputes?

SECTION D
Question number 35 to 43 carry 3 marks each [27]
35. Explain how statistical data is useful in the study of economic problems? (Discuss any two)
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36. Explain three occupational structure of the economy.

37. Sustainable development is more theoretical but an important concept. Explain

38. Write a note on different health centres opened in rural areas by the government as a part of
social infrastructure.

39. What is liberalization? What are its effects in the Indian economy?

40. Discuss National Security Help as a programme to reduce poverty?

41. Explain the reasons of low death rate in India?

42. Distinguish between unemployment in developed and a developing countries.

43. Explain the classification of Industies on the basis on ownership.

SECTION E

Question numbers 44 to 48 carry 5 marks each [25]
44. Expalin the achievements of Indian Planning.
45. How does urbanization take place? Discuss the positive and negative effects of urbanization.
46. Analyse the main problem of Indian Agriculture.
47. Discuss the importance of industries in the Indian Economy.
48. The following is the area under cultivation with improved seeds in percentage. Draw a bar

diagram for the data given and analyse it.

Crops 1980-81 1997-98
Wheat 72 86
Rice 45 74
Maize 26 57
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ENGLISH- 11

Section : A : Textual Prose

L. Select the correct alternative and rewrite the complete sentence:- [3]
1. The police checked Ladhu’s bag to see if

a. he had stolen any jewellery.

b. he was hiding a high-caste child in it.

c. he was stealing grains from the farm.

2. Mr. Acharya feels that there is no need to be gruff and rude while saying ‘no’. An
response is appreciated every time.

a. obliging

b. honest

c. impulsive

3. According to the father, the moth would not get anywhere chasing the stars because...
a. it is not what a moth should do.

b. the society is not co-operative.

c. the lamps are the things for a moth to hang around.

II. Read the following passage carefully and answer the questions given below it:- [5]

The doctor explained to us that the pathogen called Human Immuno-deficiency Virus
infects persons but does not induce illness for quite sometime. This period can be prolonged by
administering a combination of anti-HIV drugs. Actually, AIDS has no symptoms of its own. HIV attacks a
person’s immune system and weakens it so much so that the patient finds it increasingly difficult to resist
the onslaught of diseases like pneumonia and tuberculosis. Such diseases, called Oppstumistic
(Opportunistic) Infections (Ol) become life-threatening in spite of therapies especially directed to treat
them. Eventually, the patient dies.

Questions:
What does HIV stand for? Can it be diagnosed early? Why?

. What is the impact of the pathogen on the immune system?

Find words form the passage which means the same as —‘treatment intended to relieve or heal a physical
illness’ and fierce attack’.

Give adjectives of : ‘virus’ , ‘system’.

Use ‘onslaught’ in a sentence of your own.

II1. Answer the following in 6-7 sentences:- [12]
“Don’t leave your personal diaries lying around”. Why does Ruskin Bond say so?

. Describe Jakhra’s tragic end.

How did the moth, cope with his failure of not reaching his goal? What was the reaction
of the society to this?
Describe Drona as a royal elephant.

Section B — Textual Poetry and supplementary Reader

IV. Read the following stanza carefully and answer the questions that follow:- (2]
How happy is he born and taught
That serveth not another’s will;
Whose armour is his honest thought
And simple truth his utmost skill?

Questions:
What is the armour of the ‘happy man’?
What is the secret of happiness of the “happy man’?

V. Read the following stanza carefully and answer the questions that follow:- [3]
Turn, turn my wheel ! ‘Tis nature’s plan
The child should grow into a man,
The man grows wrinkled, old and gray,
In youth the heart exults and sings,
The pulses leap, the feet have wings,
In age the cricket chirps, and brings
The harvest home of day.
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Questions:

What is nature’s plan?
How does the poet glorify the youth?
Name and explain any one figure of speech from the above lines.

VI. Answer the following in four or six sentences each: -
How can the other senses compensate the blind boy for the loss of sight?

. Why do you think that the poet does not want to free himself of all fetters?

How does Alexander Pope describe a ‘happy man’?

VII. Answer the following in seven or eight sentences each:-
What is the tale of the king according to the grandmother in the story ‘Scattered Ashes’?

. What qualities make M.S.Subbulakshmi the ‘nightingale of the nation’?

Examine the twist in the tale at the end of Saki’s story.

Section C — Grammar

VIII. Use the appropriate form of the words given in the brackets and rewrite the sentences:-  [5]

We [come] to this house in 1975 and [live] here ever since.

Many a boy [was/were] present.

The boys were about their behaviour. [apology]

The man used a to cut the pieces. [chop]

The girl who won the beauty contest is proud. She should be . [Use the opposite
of the underlined word]

His is improving. [pronounce]

goes hand in hand with order. [Use synonym of ‘liberty’]

The has made wearing of helmets compulsory for the of the people.

[govern, safe]

IX. Rewrite the given sentences selecting the appropriate meaning of the idioms / phrases:- [3]

1. He is so thoughtless, every time he opens his mouth, he puts his foot in it.

[to kick someone, to make a big blunder, to hurt someone’s feelings]
2. The great immigration rush was a long way off. [unreachable, far away, closed down]
3. The efficients are emitted by extraction or manufacturing process of the plastic.

[to be surprised, to be saved, to be secreted]

X. Given below is the conversation between Kumar and Rahim. Complete the following,
reporting what they discussed :-

Kumar : This food smells good!

Rahim : If you think that it smells good, it means you’re hungry.

Kumar : This cafeteria serves good food always. Whenever buses halt here enroute
their journey, travelers enjoy some special delicacies.

Rahim : Yes, it is because they use good oil and fresh vegetables.

Kumar : Let’s go taste something today.

[4]

Kumar remarked............... Rahim told him............... Kumar agreed.............
Enjoyed byall ................ Kumar suggested.................
XI. Transform as directed:- [8]

At six in the evening when I walked home it was dark again. [Make Simple]

There was little to remind me of India. [Add a Question tag]

I will wring out rags in boiling water and lay them on his stomach. [Change Voice]

Stars aren’t the things to hang around. [Make affirmative]

I’m sorry but we can’t use your blood. [Make Complex]

Ladhu thought of Jakhra’s mother who was as rosy and as charming. [Change degree]

Jakhra had achieved that difficult feat through the magic power. [Make Negative]

On the other hand, not saying ‘no’ can be too much of a good thing and can actually
make you less productive. [Remove ‘t00’]

Section D — Reading

XII. Read the following poem carefully and answer the questions given below:- [5]
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The voice said, “We are at War’
And | was afraid, for | did not know what this meant.
My sister and | ran to our friends next door
As if they could help. History was lessons learnt
With ancient dates, but here
Was something utterly new,
The radio called the wireless then, has said
That the country would have to be brave.
There was much to do.
Questions:
What frightened the poet?
Why did she and her sister go next door?
How did they know of the war ‘then’?
‘History was lessons learnt, with ancient dates, but here was something utterly new.’
Why does the poet say thus?
What is the message that the poet wishes to convey?

XIII. Read the following extract carefully and answer the questions given below:- [5]

He pressed onwards all alone till he reached the regions covered with perpetual
snow. There by day it was burning hot and it night it was freezing cold. Going still further
he found on a plateau, covered with solid ice, a man crying in agony as blood dripped down
his body; for a toothed iron discuss was whirling round his head saving through the bones
of his skull. It was a most painful sight. The scholar hastened to this man and said,
“What is the meaning, Sir, of the ordeal you are suffering? Is there anything I can do for you?
Please tell me.”

At this the man started laughing, while the toothed iron discuss left his head to settle
on the scholar’s head. “ Now”, he said mockingly, “Now you know the answer. Once I came here,
dear scholar, with a quill in my hand and found another man in this very plight. And the moment
I asked him what he was doing in this God-forsaken place, his discuss settled on my head. You
wait here till another quill-carrying fortune seeker turns up.”

Questions:
Where did the scholar finally reach?
What happened as soon as the scholar spoke to the man?
If you were the scholar, what would you have done on seeing the man facing the torture?
Find out from the paragraph the meanings of the following words which mean the same as:
a. unending b. predicament
5. The scholar hastened to this man and said,
“What is the meaning, Sir, of the ordeal you are suffering? Is there anything I can do for you?
Please tell me.” [Write in Reported speech]

XIV. Read the following extract and make a précis reducing it to 1/3" its size, giving ita
suitable title. [5]

Are you routinely disrespectful of your teachers? Of course not, you might say.
Sure, you might have given a few (or all) of them funny nicknames. Pretty harmless stuff. All
students do it. ( And for all we know, teachers probably have equally funny, if not even funnier,
nicknames for their students. So it’s quits.

No, referring to your teachers by funny nicknames amongst yourselves is not showing
them disrespect. It’s part and parcel of being students, of occasionally thumbing a nose at figures
of authority, just for the heck of it.

But — without realizing it — it’s only too likely that you do, openly and to their face
disrespect — your teachers. How do you disrespect — really disrespect — your teachers as teachers?
You disrespect them when you accept anything and everything they tell you without question,

even when you find it difficult to understand or believe what they’re telling you.

"When you blindly follow your teachers’ teachings, when you take notes of whatever
they’re saying in the class without thinking about what you are noting down, you are disrespecting
your teachers. You are disrespecting them not only as individuals; you are disrespecting their
profession as a whole. You are treating them as guards manning a security check which you have
to get through by unthinkingly following instructions. What is this security barrier that you have
to get past in the classroom? Exams, of course. Particularly the big, bad ‘B’ word — the BOARDS.
The nightmare of all students.

The need to get through this scary security check of exams has become the main concern
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of most, if not all students. It’s a frightening situation. And a tragic situation. Both for students and
for teachers. Because, out of examophobia — a fear of exams, and the results you get in

those exams — neither students nor teachers can do their jobs properly. And that to learn and

to teach.

Learning and teaching are not two separate jobs, but one. While teaching — properly
teaching — a good teacher learns as much from good students, as the students learn from their
teacher. And good students are those who are respectful of their teachers in the true sense.

Not by unthinkingly following their teachers’ instructions like programmed robots (and keeping
their robot fingers crossed that this will help them pass in their exams, particularly the dreaded Boards)
but by learning to question what they can’t follow in what is being taught.

It is not disrespectful to question your teachers, if your teachers are good teachers
(teachers who learn from you as much as they want to teach you). What is disrespectful is not

to question your teachers when you feel that what they are teaching you raises more
questions than supplies answers.

Just for a moment don’t think of the questions that will be asked of you in the next exams.
Just for a moment, think of the questions you would like to ask your teachers in class. Just for a
moment, think of showing some real respect for your teachers. Not by sucking up to them, but
by helping them to learn from you.

XV. Read the following extract carefully and make sensible notes on the same .Use at least four
abbreviations:- [5]

Section E— Writing

XVI. Your school has celebrated its Silver Jubilee on completion of its meritorious service to the cause of
education. Now write a report of this occasion to be published in ‘The Times of India’,
Ahmedabad. [5]

XVII. You are Mohan/Mohini Kumar from 23,Sombaug Road, Camp Area, Vadodara. Write an
Application in response to the following advertisement. ‘WANTED Marketing Executives’

all over Gujarat State. Apply giving details of qualifications, experience, expected salary, etc.

to Mr. Suresh Agrawal, Plastic Industries, K.K.Marg, Vadodara. [7]

XVIII. Write an essay of about 250 words on any one of the following:- [8]

Road Rage
[Increasing incidents of deaths — accidents - endemic disorder-lack of self discipline — sense

of superiority due to owning bigger vehicle — family and work related stress — city layout, jams-
absence of severe penalty for Defaulters]

OR

English — The Window to Knowledge

[International Language — wide sphere — exploration of knowledge through the internet —
language of professionals — wider knowledge — builds confidence]
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ACCOUNTS-I
Section-A
Question No.1 to Question No.10 are multiple choice questions. From the given options, select the
correct one. Each question carries one mark. [10]

1. What is interest on partner’s capital for a partner?
a. Expenses b. Payables c. Income d. loss

2. Where would you disclose dead stock of Rs. 300 in final accounts, which is given
in trial balance?
a. Dr. to trading account b. Cr. to trading account  c¢. Dr. profit and loss account
d. Assets side

3. Which reserve is created on good debtors —
a. Bad debt reserve b. General reserve c. Discount reserve d. Capital reserve

4. Good will 1s —
a. A tangible asset b. Intangible asset c. A fictitious asset d. not an asset

5. Workmen profit sharing fund is —
a. An asset of firm b. A liability of firm. c. A loss of firm d. Profit of firm

6. To give public notice of retirement of an active partner is —
a. Advisable b. legally required  c. Voluntary d. Compulsory

7. If a partner brings his share of goodwill in cash, in which proportion will be
credited to old  partner’s capital account?
a. Profit-loss ratio  b. Profit-loss new ratio c. Sacrifice ratio d .equal ratio

8. Reconstruction of partnership means —
a. Change in profit sharing ratio amongst existing partners
b. Admission of a new partner in a partnership fund
c. Retirement or death of an existing partner
d. All of the above

9. Another name of profit and loss adjustment is —
a. Profit and loss account b. Profit and loss appropriation account
c. Revaluation account d. None of the above
10. A gets half of B’s share and C gets 1/3" of A’s share. What will be the
new profit and loss ratio?
a. 1:1:1 b. 3:6:1 c.2:2:1 d. 2:6:1
Section -B
For Question 11-20, give answer in one or two lines. Each question carries one mark

[10]
11. Mention the purpose of partnership deed.
12. Why is revaluation account prepared at the time of reconstruction of partnership?
13 While calculating partners gain if answer comes to negative then what it suggests.
14. What does debit balance of profit and loss adjustment account indicate?
15. How is the value of goodwill , when there is keen competition in the business?
16. State any two objectives to prepare annual accounts of a partnership firm.
17. Why does a partner get retired?
18. Mention any two factors affecting the valuation of goodwill.
19. Define super-profit.
20. Name ant three reserve which are not distributed amongst partner at the time of Death of Retirement
of a partner?.

Section C

Answer briefly for Questions 21-30, Each question carries two marks. [20]
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21. Mita withdraws Rs.200/- in the beginning of the every month while Milind withdraws
Rs.200 at the end of every month. If Interest on drawing has to be calculated at 12%,
then what amount of interest will be paid for each partner.

22. Amount of closing capital of Asha is Rs.16,000 after giving effect for current year’s
drawing of Rs.1000 and divisible profit of Rs.1500.How much interest on opening
capital at 5%p.a.?

23. A and B are the partners of a partnership firm sharing profit and loss equally.

They decided to change their profit loss sharing proportion to 1:3 for future.
Calculate sacrifice ratio.

24. X and Y are partners sharing profit in the ratio of 3:2.They admitted C for 1/6" share
in profit. Z would receive his share from A and B in the proportion of 2:1. Compute
new profit sharing ratio.

25. M and N are partners sharing profit and loss in equal proportion. They admitted Z
to give 1/3" share in the partnership. Z brought cash, other assets and liabilities as
capital are:

1. Cash Rs.8000 2.stock Rs.12000 3. Creditors Rs.5000 4.Bills payable Rs.2000
5.Debtors Rs.2000
Pass the journal entry.

26. Rita, Meeta and Geeta are partners sharing the profit loss in the ratio of 5:3:2.Geeta
gets retired. Geeta does not withdraw her due amount of Rs.2,00,000 from the
business and retains it as a loan in the firm. Reeta and Meeta agrees to give 1/5" of

the share in profit to Geeta in place of interest, for her dues. Determine the new ratio.

27. A and B are the partners sharing profit and loss in the ratio of 3:2.They admitted R to
give 1/4™ share in their partnership firm. R would bring his capital in cash amounting
to the 1/4"™ of the net assets of new company. The net assets of firm are 42,000.
Determine the capital amount to be brought in by R in the firm.

28. Differentiate between Fixed capital account method and Fluctuating capital account .

29. By using the appropriate average, determine the value of goodwill on the basis of six
years purchase:
Year 2001 2002 2003 2004
Profit 20,000 15,000 20,000 17,000

30. A, B and C are partners of a firm. The proportion of their capitals is 3:2:1.C is to be
paid 6% commission on profit after charging his commission. If profit of the firm ,
for the year ending on 31.03.2005 is Rs.20,988,what amount should C get ?
Section D
Answer briefly for Questions 31to 40. Each question carries three marks. 30M
31. Pass adjustment entries for the following adjustments:
a. Rent receivable is Rs.10000.
b.12% interest for eight months is receivable on a loan of Rs.24000 given to Sameer.
c. Provide 10%depreciation on furniture of Rs.35,000.
32. P, Q and R are partners sharing the profit and loss in the ratio of 2:2:1.P is retiring
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from the firm and his share in the business is purchased by the remaining partners for
Rs.60,000. For which Q pays Rs.40,000 and P pays Rs.20,000.Determine their new
profit loss sharing ratio.
33. From the following information compute the value of goodwill at two years purchase
of average profit on the basis of last five years:
Year 2000 2001 2002 2003 2004
52,500 55,000 60,000 70,000 81,000

34.Ami,Aastha and Aesha are partners of a partnership firm sharing profit in equal
proportion .They have decided to change their profit and loss sharing proportion to
1:2:3 and decided to have the goodwill at Rs.45,000.Goodwill account is not disclosed
in the books. From the above information , pass journal entries for each of the
following case:
1. When full amount of goodwill is to be shown in the books of the firm.
2. When partners do not desire to show goodwill account in the books.
3. When the effect of goodwill is to be given directly to the partners capital account

(without creating goodwill account)

35. Ram and Shyam are partners in a partnership firm. Between them the proportion of
sharing profit and losses is 2:1. On 31-3-04 , following balances appeared in the
books of their firm
1. Reserve fund (credit bal.) Rs. 6,000
2. Employees Accident Compensation Fund (credit bal.)  Rs.9,000
3. Profit and loss a/c (Cr. balance) Rs.12,000

36. State the circumstances of retirement of a partner according to the Indian
Partnership Act.

37. Priyal, Sneha and Ritika are partners of a firm. Their capital as on 1-1-04 was Rs
.80,000, Rs.60,000 and Rs.160,000 respectively. After distributing profit for the year
2004,it was found that interest on capital at 8%p.a. was omitted to be calculated. Pass
journal entry for rectifying the mistake.

38. Shah, Patel and Patil are partners sharing the profit and loss in the proportion

1:2:3. When Patil retired , the following journal entry was passed for the goodwill.

Shah’s capital a/c Dr 2400
Patel’s capital a/c Dr 1200
To Patil’s capital a/c 3600
Determine the new profit-loss sharing ratio of Shah and Patel.

39.Jyoti,Deepak and Rohni are partners sharing profit and losses in proportion of
3:2:1.Jyoti and Deepak have given guarantee that Roshni must get atleastRs.18000 out
of profits. If, for the year ending on 31.03.2005 the profit of the firm is Rs.90,000,then
how the profit will be distributed among partners?

40.Ashit and Ashim are partners sharing profit and losses in equal ratio. They admitted
Arit in the partnership with condition to give 1/ 5" share in profit. Arit has brought
Rs.5000 in cash towards goodwill in business. At the time of admission of Arit,
goodwill account stood at Rs.20,000 in the books of the firm. If the goodwill is

shown at its old value in the books of the firm, then pass necessary journal entries.

Page 23 of 56



NAVRACHANA VIDYANI VIDYALAYA

Question No41 and 42 are essay type questions. Each question carries 10 marks. [30]

41. Chavi and Chaya are partners of a firm sharing profit and loss in the ratio 2:1. The

Section-E

balance sheet of the firm as on 31.12.2006 is as under

Balance Sheet as at 31.12.2006

SAMPLE PAPERS 2010-11

Liabilities Amount (Rs.) Assets Amount (Rs.)
Capital Account Furniture 20,000
Chavi-20,000 Building 50,000
Chaya- 60,000 80,000 Stock 5,000
Profit and loss A/c 6,000 Debtors 15,000
Creditors 10,000
Bills Payable 2,000 Cash Balance 8,000

98,000 98,000

On the date of balance sheet, partners admitted Chetna as a new partner with the following conditions:
1. Chetana would bring necessary amount in cash towards capital on the
basis of his profit loss ratio and Rs.5000 in cash towards goodwill.
2. New value of the building is Rs.60,000.
3. Increase the value of furniture by Rs. 2,000.
4. Provide 10% bad debt reserve on debtors.
5. Outstanding income of Rs.1000 is not recorded in the books ,
which is to be recorded.
6. New profit loss sharing ratio is determined at 2:2:1.
From the above information prepare necessary account and balance sheet in the books of firm.

42. P,Q and R are partners in equal proportion. The balance sheet of their firm as
at31.12.03 is as under:
Balance Sheet as at 31.12.2003

Liabilities Amount (Rs.) Assets Amount (Rs.)
Capital Account Land Building 12,000
P 15000 Furniture 6,000
Q 12000 Motor car 9,000
R 9000 36,000 stock 7,500
General reserve 3000 Debtors 22,500
Creditors 17,000
Bills Payable 1,000
57,000
57,000

R retired on 1.1.04.on the same day, the following terms are decided;

1. Increase the value of land building and furniture by 10%.

2. Reduce stock value by 500.

3. Debtors of Rs.600 are bad and to be written off.

5. Bills Payable of Rs.200 are now not payable.

When R retires, the goodwill is determined for Rs.7200.The accounting treatment only for the share of the
goodwill of R is to be given and the same is to be shown in the balance sheet .Retain the dues of R as a loan
in the firm.

Prepare the necessary accounts to incorporate the above transactions and also prepare balance sheet after
retirement of R.

43. Lal ,Bal and Pal are partners of a Partnership firm. Prepare the final accounts
from the trial balance as at 31.3.2005 and adjustments.
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Trial balance as at 31.03.2005 of partnership Firm of Lal , Bal and Pal

SAMPLE PAPERS 2010-11

Debit balance Amount Rs Credit balance Amount Rs
Capital Pal 12,000 Capital Lal 1,20,000
Drawings Lal 12,000 Capital Bal 1,20,000
Bal 12000
Pal 6000
Stock(1.4.2004) 60,000 Sales 3,00000
Purchases 1,20,000 Creditors 13,600
Sales return 3600 Interest 1440
Carriage inward 6000 Bad debt reserve 2400
Sundry debtors 72,000 Discount 2160
Trading expenses 14,400 Purchase return 2400
Wages-production 24000
Factory rent 3000
Furniture 5280
Bills receivable 2400
Advance income tax 240
Furniture depreciation
writtenoff 720
Loose tools 24000
Travelling expenses 7200
Salaries 24000
Machines(Including
office machine) 72000
Lease hold Property 24000
Discount 2640
Taxes and insurance 1200
Loan 24000
Bank balance 27600
Cash balance 1720
5,62000 5,62000

Adjustments:

1.The closing stock was Rs.90,000
2 .Charge 5% interest on capital.

3. From the divisible profit Pal is entitled to receive Rs .2400 before distribution
of it. Subsequently the remaining profit is distributed in the proportion of 2:2:1.

4. The manager of the firm is allowed 10% commission on the profit after
deduction of such commission .

5. Provide a depreciation @ 5% on machines and @10% on loose tools.

6. A salary Rs.2400is prepaid.

7. Bad debt reserve is to be increased by Rs.4800.

8. From bills receivable one bill of Rs.1200 is found to be irrecoverable.
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BUSINESS ORGANISATION-I

Section: A

Questions 1 to 10 are multiple-choice questions. Choose the correct option and
Write its serial letter. Each question carries one mark. (A0Mm)

1.The simple method of implementing knowledge means-----
a) Science b) Art c) Profession d) Business

2.What is POSDCORB ?
a) Planning b) Organizing c) Functions of Management d) Functions of administration

3.Administration is a part of ---
a) Policies b) Decisions c)Targets d)Management

4.Who undertakes the work of preparing budgets in big units ----
a) General manager b) Budget committee c) Budget officers d) Expert officers

5.In Organization authority and responsibility flow line ally from the
top to the bottom level.
a) Line organization b)Functional organization c)Matrix organization d)Committee
organization

6.In the process of delegation of authority, authority is ?
a) Assigned b) Distributed c) Conferred d)Created

7.0n account of promotion of employees his ----
a) Authority and responsibility increases
b) Authority only increases
c) Salary increases
d) Responsibility only increases

8.The amount which is paid to candidate in apprentice training is called
a) Brokerage b) Wages c) Commission d) Stipend

9.To verify the success of plan on experimental basis )
a) Experts should be hired b) Opinions should be invited
c¢) Supporting plane should be prepared d) Implementation of plane should be made

10. Learning while working method is----
a) Complex b) Private c¢) Short and simple d) Lengthy and complex

Section B
Answer the following questions in one-two sentences.
Question 11 to 20 carries 1mark each. (20M)

11.Define managerial function.

12.State the functional areas of Management.

13.Which factors are to be considered while evaluating alternative plans?
14.Give two merits of informal organization.

15.State various types of budgets.

16.When is scientific recruitment possible?

17.When decentralization of authority is suitable in a business unit ?
18.Why staff cannot be treated as a raw material for production?
19.Define scientific management.

20.Give the names of institutes giving training of management science.

Section- C
Answer the following questions in brief. Question 21 to 35 carries 2marks each.
(30M)
21.State the main features of management.
22 Explain any four benefits of scientific management.

Page 26 of 56



NAVRACHANA VIDYANI VIDYALAYA SAMPLE PAPERS 2010-11

23.Explain Management is a human activity.

24 .Differentiate between top level management and middle level management.
25.State any two limitations of budget.

26.Explain the Principle of Harmony of group.

27 Differentiate between formal and informal group.
28.Which functions are included in staffing .

29.State the important points of conferment of authority.
30.Explain a) Fatigue study ~ b) Motion Study
31.Differentiate between centralization and decentralization.
32.Explain any two characteristics of staffing.

33.State the reasons of recruitment.

34 .Discuss any two reasons for retirement.

35.Explain —-Management as a profession.

Section- D
Answer the following questions to the point. Give answer in maximum 50 words.
Question 36 to 45 carries 3marks each. (30M)

36.State the Limitation of scientific management.

37.Explain the interrelations among the different levels of management.
38.Explain the process of preparing Report.

39.Explain the importance of training.

40.Differentiate between Promotion and Demotion.

41.Explain- “Employees are the limb of business”.

42 State the limitations of Functional organization.

43.Discuss-‘There are three pillars of the tripod of delegation of authority.’
44 .Give three suggestions to make committee organization effective.

45 .Discuss- “Planning allows us to master change’’.

Section - E
Answer the following questions in detail. Give answer in maximum 100 words.
Question 46 to 49 carries 5marks each. (20M)

46.Explain in detail the limitations of Planning.
47.Give the meaning of organization and explain its formation.
OR
Explain Line organizations in detail.
48.Give the meaning of recruitment. Explain external sources of it.
49.What is Planning? Explain its characteristics.
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BUSINESS ORGANISATION- 11

Section: A

Questions 1 to 10 are multiple-choice questions. Choose the correct option and write its serial letter.
Each question carries one mark. (10M)

1. Administration is a part of ---
A) Policies b) Decisions c)Targets d)Management

2. The simple method of implementing knowledge means-----
a) Science b) Art c) Profession d) Business

3. Who undertakes the work of preparing budgets in big units ----?
a) General Manager b) Budget committee ¢) Budget officers d) Expert officers

4. What is POSDCORB?
a) Planning b) Organizing c) Functions of Management d) Functions of administration

5.In Organization authority and responsibility flow line ally from the
top to the bottom level.
b) Line organization b)Functional organization c)Matrix organization d)Committee
Organization

6. On account of promotion of employees his ----
a) Authority and responsibility increases
b) Authority only increases
c) Salary increases
d) Responsibility only increases

7. The amount which is paid to candidate in apprentice training is called
a) Brokerage b) Wages c) Commission d) Stipend

8. In the process of delegation of authority, authority is
a) Assigned b) Distributed c) Conferred d) Created

9. Learning while working method is----
a) Complex b) Private c¢) Short and simple d) Lengthy and complex

10. To verify the success of plan on experimental basis .
a) Experts should be hired b) Opinions should be invited
c¢) Supporting plane should be prepared d) Implementation of plane should be made

Section B
Answer the following questions in one-two sentences. Question 11 to 20 carries 1mark each. (10M)
11. State various types of budgets
12. Name the functional areas of Management.
13. Which factors are to be considered while evaluating alternative plans?
14. Give two demerits of informal organization.
15. Define manager.
16. When is scientific recruitment possible?
17. When centralization of authority is suitable in a business unit?
18. Why staff cannot be treated as a raw material for production?
19. Define scientific management.
20. Give the names of institutes giving training of management science.
Section- C
Answer the following questions in brief. Question 21 to 35 carries 2marks each. (30M)
21. State the main features of management.
22. Explain any four benefits of scientific management.
23. Explain —-Management as an art.
24. Differentiate between top level management and bottom level management.
25. Discuss any two reasons for retrenchment.
26. Explain the Principle of division of labour.
27. Differentiate between formal and informal group.
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28. Which functions are included in staffing?

29. State the important points of conferment of authority.

30. Explain a) Fatigue study ~ b) Motion Study

31. State any two characteristic of budget.

32. Explain any two points showing the importance of staffing.
33. State the reasons of recruitment.

34. Differentiate between centralization and decentralization
35. Explain - Management is a continuous activity.

Section- D
Answer the following questions to the point. Give answer in maximum 50 words.
Question 36 to 45 carries 3marks each. (30M)

36. Differentiate between Promotion and Demotion.

37. Explain the interrelations among the different levels of management.
38. Discuss- “Planning allows us to master change’’.

39. Explain the objectives of training.

40. State the merits of scientific management

41. Explain- “Efficient staff is an invaluable asset of an enterprise”.

42. State the limitations of Functional organization.

43. Discuss-‘There are three pillars of the tripod of delegation of authority.’
44. Give three suggestions to make committee organization effective.

45. Explain the process of preparing Report.

Section - E
Answer the following questions in detail. Give answer in maximum 100 words.
Question 46 to 49 carries Smarks each. (20M)

46. Explain in detail the limitations of Planning.
47. Give the meaning of organization and explain its formation.
OR
Explain Line organizations in detail.
48. Give the meaning of recruitment. Explain external sources of it.
49. What is planning? Explain its characteristics.

Page 29 of 56



NAVRACHANA VIDYANI VIDYALAYA SAMPLE PAPERS 2010-11

BUSINESS ORGANISATION-I111

Section: A

Questions 1 to 10 are multiple-choice questions. Choose the correct option and write its serial letter.
Each question carries one mark. (10M)

1. Communication is the process of making the other person aware of the message and-----
a) To control the message b) Of direction ¢) Of coordination d) To give understanding

2. Success of principles of management depends upon ----
a) Human nature b) Manager c) Machine d) Organizing

3. Which is the responsibility of business to protect zero pollution?
a) Economic responsibility ~ b) Legal responsibility
c¢) Moral responsibility d) Voluntary responsibility

4. Who is the author of Principle of Scientific Management?
a) F.W.Taylor b) Dr.G.R Terry c) Peter F. Drucker d) Koontz and O’Donnell

5.In Organization authority and responsibility flow line ally from the
top to the bottom level.
c) Line organization b)Functional organization c)Matrix organization d)Committee
Organization

6. Which industry was nationalized in India after independence?
a) Railway b) Vehicles c) Ship d) Cloth

7. - is an element of directing.
a) Planning b) Control c¢) Supervision d) Staffing

8. The first step of the process of delegation of authority is
a) Assignment of responsibility b) a qualified person c) delegation of authority d) the
determination of accountability

9. The main reason for industrial dispute is----
a) Worker’s behavior b) Wages c¢) Manager’s behavior d) Lack of facilities.

10. The budget covering various divisional budgets is called------

a) Financial budget b) Cash budget
¢) Production budget d) Master budget
Section B

Answer the following questions in one-two sentences. Question 11 to 20 carries 1mark each. (10M)
11. Write the suitability of line organization.

12. Which things are chiefly included in Management?

13. What is essential for planning?

14. Clarify the meaning of Co-partnership.

15. Explain the term HRM

16. When the corrective action not taken?

17. Give the order of hierarchy needs suggested by Abraham Maslow.

18. What is accountability?

19. Give the full form of GATT.

20. Write any two functions of the NGO working for the consumer protection.

Section- C

Answer the following questions in brief. Question 21 to 35 carries 2marks each. (30M)
21. What is social security scheme for employees?
22. What are the benefits of management to society?
23. In which six groups Henry Fayol has divided the activities of industrial organization?
OR
Explain the nature of the principle of management.
24. State the four benefits of decentralization.
25. State the reasons of demotion.
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26. Discuss-World is global village.
OR
Increase in national income is a favorable factor to business.-Discuss.
27. Write any two barrier of communication.
OR
‘See and Know’ is a better motto than ‘Read and Learn’.-Still the importance of reporting had
not been decreased. Explain.
28. What is stating principle of trusteeship of Gandhiji about consumer?
29. Explain any four advantages of centralization..
30. Explain a) Fatigue study  b) Motion study.
31. What are eco-friendly products?
32. Explain the difference between recruitment and selection.
33. ‘Scope of direction is wide’-Explain.
34. What do you mean by human rights?
35. ‘Business and society are inseparable’-Explain.

Section- D
Answer the following questions to the point. Give answer in maximum 50 words.
Question 36 to 45 carries 3marks each. (30M)

36. Describe the stages in the process of budgeting.
37. Explain the following principles:
a. Principle of authority and responsibility  b. Principle of order.
c. Principle of stability of tenure.
38. There are three pillars of the tripod of delegation of authority-discuss.
OR
There is thin line of distinction between delegation and decentralization.
39. Bring out clearly the difference between training and development.
40. State the demerits of piece wage system.
OR
Discuss the elements of an ideal wage system.
41. Write a short note on the importance of leadership.
42. Explain the negative aspects of economic environment in India after1991.
43. Explain the importance of control.
44. Describe the scope of Market management.
OR
Explain the functions of financial management.
45. Bring out the difference between oral and written communication.

Section - E

Answer the following questions in detail. Give answer in maximum 100 words.
Question 46 to 49 carries Smarks each. (20M)

46. Give an idea about the responsibilities of consumer.
47. State the types of organization. Discuss committee organization in detail.
OR

Give the meaning of organization and explain its characteristics.
48. State the types of training and explain in brief the types of training for workers.
49. What is planning? Explain its stages.

OR
Discuss the elements of planning.
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MATHEMATICS- |
SECTION A
1-15 (15m)
LIflim,_p kx cosecx = lil,_q X COseChX then k =
a) +1 b) 2 c)0 d) does not exist
alsr
F omm 'H'f'] — —
2fp =% then i
(n-+1)x b) (n -+ 1)! c)nlx d) n!
1 7
3. g, |||I 1
g [HE-HI :».E-H + n¥ el L ie 'wm'ﬂ]
2 1
a) 1 b) 3 c) 3 d)o
4. [e*lBe g¥ely =
(ae)” +c b) =—— o €c) — d) none of these
logiqe] 1+log (qal
s flx]dxm (2= x<—1)
a) =X +¢ b) =2x + ¢ c)—x% +¢ d) &% + ¢
6.Horizontal Range of the particle is R, then it's maximum height is
R R
a) R b) = c) n d) 2R

7.Length of subtangent at buy point of the curve is constant, then its equation is
a) X mggW b) v m ¢ @™ c) 1? = Zre” d) x? = Zee¥
8.Centroid of the &4 5 (. with vertices A(0, 0), B(€Q8 &, 8iI1 €r) and C(8in &, — €08 &) and lies on

line v — Zx = () thenar =
a) Tan(2) b) tan™(-1/2) c¢) tan™(1/3) d)tan™(-3)
9.Which of the following is (p - ¢t) form of the line [t x + v + 2 =0

a) xcos(::-+1 smt;}—w,.
b) X CO8 (—1} + y8in t:— 1} =12

c) X CO8 ﬁ}-f—‘t sin(—)-wz

d) XCos8 —;+3-’3m (:} =2
10. From which of the following point line perpendicular to the tangent of the
circle x* 4+ ¥4 — 25 — 2y + 1 = 0 passes?

a) (-1,1) b) (-1, -2) c) (-1, 2) d) (-1, 1)
11. Line }* m MMX < ¢ is tangent to the parabola j-‘i = 4a(x + a) them

gL+ — = . (@ = 0)
BT
a) Z2¢ b) —c c)c d) :3 ¢
.d L‘
12. If the equation — + "—3 = ] represent ellipse then
.l

a) r>2 b)2<r<5 c)-2<r<A1 d)-5<r<2
13. If equation 5,1‘5 -1-,3_}-‘7" = 2 [ represent the rectangular hyperbola then

a) A=5 b) A m & c)A=-5 diA=—4

14. p # (1l is the value of the co-ordinate at which sphere

¥ + y? 4+ 22 — 3x — 37 — 3z = (lintersects the axis other than origin, then p =

a) p=1 o) p = = p=0 dp =23
15. |f("€'f'“f‘)-E and |X|=4 |F| =Zthen |[F X T| =
a) 2 b) 4 c) 2 d) %

Page 32 of 56



NAVRACHANA VIDYANI VIDYALAYA SAMPLE PAPERS 2010-11

SECTION B
16 — 30 (15m)
16. Find approximate value of glp== (0.49).

17. Solve the differential equation X (1 + ¥*Jdx — v(1 + x*)dv =0

18. Sum of two numbers is 45 and product of square of one with other number is maximum, then find
the numbers.

19. If _f_*] F(x)dx = 4 and g" 83— Flx)cdx =7 then find .[;'] Flx)dx

50. Obtain: _r.‘*r‘Em x (Eh'.l 5-+;'::E:-+]ﬁﬁ“.,1l-} i

21. What will be height of the particle if its projected in vertical upwards with speed 4.9m/sec.?

i (x ™ 0)

2. | s

23. Find the equation of the line which makes an angle E with ¥ axis whose V' intercept is v 3 unit.

24. Midpoint of the chord of circle x# = +# = 25 is (Z,=3), then find its equation.
ER-

25. Get the equation of the auxiliary circle of the curve % - '; -]

26. Find the projection of (ﬁ‘l b, E-':l on the X axis and its magnitude.

27. If &, ,E {T are mutually orthogonal unit vectors and {] E = . Prove that E m I

¥ v &g &=3 _ y-1 _ a+d
28. Prove = = == = = and = = = — are skew.

- -3 = -

29. X G QU, ;1} and f{x) = tan x — x then prove that Tall X = X (using derivatives).

30. Evaluate lim (‘Eﬁ—\ﬂ}x
: e N aBege
SECTION C
31-40 (20m)
31. For which value of k, points (k, 2 — 2k), (=k + 1,2k and (—4 -k, & — 2k)

are collinear?
32. Prove that line segment on any tangent to the parabola between the point of contact and the
directrix subtends a right angle at the focus.

i -
33. Find the co-ordinates of the endpoints of the latus rectum of the ellipse % == ':; =
[

34. Show that the point of intersection of the asymptotes and the directrices are the auxiliary circle.
35. Prove that angle in a semicircle is a right angle.

B
36. lima_-im. Evaluate.
5 2 U0ER=1
37.%,¥ €ER, flx+y) = Fx) - FOr)if f(x) m 1+ xg(x)and 11;1%-53(,3;) = 7] then find
P
£ ()

38. Using mean value theorem prove that

= ml o s -
ARty S (x = Q)

39. Evaluate [ cosec? xdx.

av i
40. Solve = =+ = — logx
ax % i~

SECTION D
41 -50 (30m)
41. If no three of A, B, C, D are collinear and they are all in the same plane, prove that area of

AFPAEB + area of APBC + area of AFCA = area of A4BC.
42. If ¢ == (1 find the equation of the circle that touches each of the lines x = (}, * = ¢ and

dx+4y+ba =0
43. Prove that for an equilateral triangle, Centroid and incentre are the same point. Hence find the
incentre of &4L L where Ais (6, 4, 6), Bis (12,4, 0)and C is (4, 2, -2).
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44

45.

46.

47.

48.

49.

50.

51-54
51

52.

5

w

54

. Find the shortest distance between thelines ¥ =1+ t. v =1+ 6t,z2= 2t ¢ € Rand
Xml+2kymE+15kzm=2+6k RER

Find the equation of the line of intersection of the planes ¥ + 17 + z = 3 and
2x+y—+3z=7

1g™%dx
Evaluate - df
¢ 1+at
PR
Obtain the area enclosed by “_3 -t ']? = ] and two axes.
-
in"a .
Find | ==—=dx

glna
Solve 5-;— — coz(x = 1) = sin(x =+ ¥)

Acceleration of the particle is constant and it covers the distance 600m and 720m in 10 and 12
seconds respectively. Find its initial velocity.
SECTION E
(20m)
. Show that the quadrilateral formed by the lines ax £ bv + e =0, ax £ by +¢ =0isa
Zo&
rhombus and that its area is E

. Tt (e b
Find: Wiy ———"— (R & V)

|:_;.- - ]:IE

. P dvi #
If kv = ginfx + 1) then prove thatE'e' . lf:l - Ela-} vy m

CFind [ vtanx + +cotx dx

OR
[ xlog (:—’}m
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PHYSICS-I
SECTION -A
e Question Nos. 1 to 16 are multiple choice questions. Each carries one mark. Choose the correct
answer (a or b or c or d) from the given alternative response and write it. 16
1. Two identical metal spheres A and B carry same charge g. When the two spheres are at distance r from
each other, the force acting between them is F. Another identical sphere Cis first brought in contact
with A, then it is touched to sphere B and then separated from it. Now the force acting between A and
B at the same distance is

(a) F (b) 2F (c) 3F/8 (d)F/4
2. An electric dipole is placed at the centre of a sphere. The flux passing through the surface of the sphere
is . (a) Infinity (b) zero
(c) can not be found (d) 29/,
3. The dimensions of permittivity [€q]are . Take Q as the dimension of charge
(a) ML’T?Q? bym L’ Q! eoML*T?Q? (d) M-1L3T-2Q-2
4. If the hot junction is made cold and the cold junction is made hot the
(a) direction of e.m.f. does not change. (b) direction of the current gets reversed.
(c) direction of current does not change. (d) current is not obtained.

5. A wire of resistance R is cut into n equal parts. These parts are then connected in parallel. The
equivalent resistance of the combination is

(a) nR (b) R/n (c) n/R (d) R/n?

6. A stationary charged particle does not experience any net electromagnetic force then
(a)magnetic field may be zero or nonzero. (b) magnetic field must be zero (c) electric
field may be zero or non zero. (d) electric field must be zero.

7. A wire of 2m is bent in the form of a circular loop. The magnetic moment of the loop
when 1A current flows through it is Am?Z.
(a)2m (b)1/m (c) m/2 (d) m/4
8. The speed of a charged particle in a Cyclotron is independent of
(a) its mass (b) its charge (c) its linear speed (d) magnetic field
9. Aninductor stores energy in its
(a) electric field (b) conducting wire
(c) magnetic field (d) electric and magnetic field

10. Speed of a particle moving through a magnetic field is increased then the radius of curvature of its
trajectory will

(a) decrease (b)increase (c) not change (d) becomes half
11. law is integral form of Biot Savert’s Law.
(a) Coulomb’s (b) Gauss’s (c) Ampere’s (d) Newton’s
12. Relative permeability of one substance is 0.075, its magnetic susceptibility is __. (a) 0.925
(b) -0.925 (c) 1.075 (d) -0.075
13. At a place, By, of earth’s magnetic field is V3 times its Bv component. The angle of dip at that place is
(@)o (b)rt/3 (c)m/6 (d) m/2
SECTION - B

e Questions, 17 to 32 are very short questions, each carrying ONE mark.
14. State the law of conservaton of electric charge.
15. What is electric field intensity?
OR
State Gauss’s theorem.
16. Give an example of a dipole in a non-uniform electric field.
17. Draw an equipotential surface if there exist a uniform electric field along X-axis.
18. State Joule’s Law.
19. What is Meissner Effect?
20. Draw the graph of resistivity versus temperature for nichrome and silicon.
OR
What is thermoelectricity?
21. At room temperature, electrical conductivity of electrolytes is 10” to 10 times that of a metal. State
two reasons for this.
22. State Biot Savart’s Law.
OR
State the principle on which the galvanometer works.
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23.
24.
25.
26.

27.
28.
29.
30.
31.
32.

33.
34.

35.
36.
37.

38.
39.
40.
41.
42.

43.

44,
45.

46.

47.

48.

49.

50.

What are eddy currents?
State the resonance condition for cyclotron.
State Ampere’s circuital law.
The susceptibility of a magnetic material is 0.9853. Identify the type of the magnetic material. Draw the
modification of the field pattern when a specimen of this material is kept in a uniform magnetic field.
What is angle of declination?
hiopu
gukl
ljh
Ihl
Under what condition an electron moving in a magnetic field experiences (i)no force (ii) maximum
force.
OR
Write one difference between the paramagnetic and ferromagnetic substance.

SECTION -C

Questions, 33 to 48 are short answer type questions, each carries TWO mark. 32
Explain the behaviour of an electric dipole in an uniform electric field.
Derive an expression for the electric field due to a uniformly charged infinite plane sheet.
OR
Derive an expression for the electric field due to a uniformly charged thin spherical shell at a point
outside the shell.
Obtain the expression for energy stored in a charged capacitor.
Obtain the expression for the electric susceptibility of the dielectric material.
Deduce the relation between the resistivity and relaxation time of a conductor and hence show that
resistivity increases with temperature in a conductor.
OR
Explain terminal voltage of a battery with the help of diagram.
Explain Peltier effect.
What is shunt? Obtain the formula for shunt.
Explain charging process in a lead storage cell, using necessary circuit.
Using Ampere’s circuital law, obtain equation for magnetic intensity of a solenoid.
Obtain an equation of Lorentz force.
OR
Obtain the expression for the force acting between two conducting wires placed parallel to each other
and carrying currents in the same direction.
Write Faraday’s law of electromagnetic induction when a conducting rod is moving perpendicular to the
magnetic field. Explain the reason behind the induced emf.
What is self induction? Derive the formula for self inductance of a circuit.
Explain the effect of temperature on ferromagnetic substances and define is curie temperature.
OR
What is the source of earth’s magnetic field? Explain.
Define coercivity and retentivity. On this basis how will you distinguish between soft
iron and steel.
Give two points of difference between the radiative and inductive components of electromagnetic
radiation.
Explain the principle of potentiometer with the help of a diagram.

SECTION - D

Answer the questions , 49 to 60 as directed. Each carries THREE mark. 36

Two spheres having same radius and mass are suspended by two strings of equal length

From the same point, in such a way that their surfaces touch other. On depositing total 4x10’ C charge
on them, they repel each other in such a way that in equilibrium the angle between their strings
become 60°.If the distance from the point of suspension and to the center of the sphere is 20 cm, find
the mass of each sphere. K =9x10° Sl and g = 10 ms™.

The surface charge density of a very large surface is equal to -3.0 x 10° Cm™. From what distance should
an electron of 150 eV energy be projected towards the plane so that its velocity becomes zero on
reaching the plane? Charge on an electronis 1.6 x 10°C, 1eV=1.6x10"J, €,=9x 10" Sl.
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51.

52.

53.

54.

55.

56.

57.

58.

59.

60.

Q amount of electric charge is residing on a conducting sphere having radius equal to R;. This sphere is
connected to another conducting sphere of radius R, by a conducting wire. Calculate the electric charge
on each of the spheres. The two spheres are separated by a large distance.

OR
15 x 10°V magnitude of electric potential is established on the spherical shell of a van-de-Graf. The
dielectric strength of the air surrounding the spherical shell is equal to 5 x 10’ Vm™. Calculate the
minimum radius of the required spherical shell.

The tungsten filament of the bulb has resistance equal to 18 Q at 20° C temperature . A current of
0.185 A flows, when 30 V is connected to it. If a = 4.5 x 102 K™ for a tungsten, then find the
temperature of the filament.

The atomic weight of copper is equal to 63.54 g/mol. Its density is equal to 8.9 x 10° kgm™ . If there is 1
valance electron per copper atom, calculate the number density of electron. Avogadro’s number is
equal to 6.02 x 102 mol™.

OR
An electron is moving on a circular path of radius 5.3 x 10" m with a constant speed 2.2 x 10° ms™.
Calculate its frequency and the electric current formed due to it.

A D.C motor draws 10 A current when it works on a 30 V supply. Find resistance of its winding if its
efficiency is 40 %.

Distance between two very long parallel wires is 0.18 meter. The currents of 8 A and 12 A are flowing in
the same direction in the two wires respectively. Find a point on a perpendicular line joining the wires,
where the field intensity is zero.

A charge Q is uniformly spread over a disc of radius R, made from a non- conducting material. This disc
is now rotated about its geometrical axis with frequency f. Find the magnetic field generated at the
center of the disc.

OR
Write the equation of magnetic force acting on a particle moving through a magnetic field. Using it
obtain Newton’s equation of motion and show that kinetic energy of the particle remains constant with
time.
Two long solenoids are of equal length | and the smaller solenoid having a cross-sectional area A is
placed within the larger solenoid in such a way that their axes coincide. Find the mutual inductance of
the system.

Two similar bar magnets have magnetic dipole moment 1.0 Am2 each. These are kept in a plane in such
a way that their axis are perpendicular to one another. The distance between their centers is 2 m. Find
the magnetic field at the midpoint of the line segment joining their centers.

OR
A steamer is to be moved in the direction making an angle of 100 South of West. The magnetic
declination at the place is 170 West of the South. In which direction should the steamer be moved with
respect to the magnetic meridian?

Q amount of charge is uniformly distributed over some body. How should the body be divided in two
parts, so that force acting between two parts is maximum for a given separation between them?

An electromagnetic plane wave is travelling along the X-direction. The electric field
vector at an arbitrary point and time is given as E= 6.3 j vm™,
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10.

11.

12.

13.

14

15.

16.
17.

18.
19.
20.

PHYSICS-II

SECTION - A

Question Nos. 1 to 16 are multiple choice questions. Each carries one mark. Choose the correct
answer (a or b or c or d) from the given alternative response and write it. 16

o and p respectively, are the surface and volume charge densities of a sphere, then
(@) o020, p20 (b)o=0, p20 (c) o20,p=0 (dJo=0,p=0
A metal of negligible thickness is introduced between the two plates of the capacitor. The value of
capacitance will be
(a) unchanged (b) doubled (c) halved (d) increased by 3 times
How many electrons will pass through a cross-section in one second to form 1.6 A current? (e = 1.6 x
10 C)

(a) 10 (b) 10%° (c) 108 (d) 10%

Neutral temperature of a thermocouple is 270°C and temperature of the cold junction is 15°C then the
temperature of inversion is °C.

(a) 255 (b) 525 (c) 285 (d) 575

Speed of a particle moving through a magnetic field is increased then the radius of curvature of its
trajectory will

(a) no change (b) decrease (c) become half (d) increase

A straight steel wire of length | has magnetic dipole moment M. If this wire is bent in the form of a
semicircle, then the new value of the magnetic dipole momentis .

(a) M/2 (b) M (c)M/ (d)2M/ 1t
Lenz’s law is a consequence of law of conservation of .
(a) charge (b) current (c) energy (d) momentum

In an A.C. circuit direction of electric current gets reversed after every 2 x 10 s. Then the frequency of
the A.C. is Hz.

(a) 100 (b) 25 (c) 314 (d)3.14
Which of the following electromagnetic waves have the shortest wavelength ?
(a) Radio waves (b) y-rays (c) ultraviolet rays (d) X-rays

Radii of curvature of both the sides of a convex lens are 15 cm if the refractive index of the material of

the lens is 1.5, its focal length in air is cm.
(a) 10 (b) 15 (c) 20 (d) 30
Reciprocal of angular resolution is called
(a) magnification (b) resolution (c) resolving power (d) none of these

Cathode rays are travelling in the directon from east to west enter in an electric field directed from
north to south. They will deflect in

(a) east (b) west (c) north (d) south
The frequency of the characteristic X- ray determines property of the target.
(a) atomic weight (b) atomic number (c) melting point
(d)atomic mass number
Half life of a radioactive element is 5 min. In 20 min, the ___ % of the substance will remain
undecayed.
(a) 9.37 (b) 25 (c) 75 (d) 6.25
. The emitter junction of the CE transistor amplifier is biased while the collector junction is
biased.
(a) reverse, forward (b) forward, forward (c) forward, reverse (d) reverse, reverse
The propagation of UHF band is via .
(a) ground wave (b) space wave (c) sky wave (d) optical fibre
SECTION -B

Questions, 17 to 32 are very short questions, each carrying ONE mark.

State the superposition principle for forces between more than two charges.

What is the condition for the potential difference between the two terminals of the battery to be
maximum?

What is ohmic loss ?

Write the mathematical form of Ampere’s circuital law.

What is the difference between electric and magnetic field lines.
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21.
22.
23.
24,
25.
26.
27.
28.
29.
30.
31.

32.
33.
34.
35.
36.

37.

38.

39.
40.
41.
42.

43.
44,

45.
46.
47.

48.

49.

State Lenz’s Law.

What is the importance of cladding in optical fibers?

How are the coherent sources obtained in Young’s experiment ?

State Heisenberg’s uncertainty principle.

What is astigmatism?

What is population inversion ?

Why neutron is considered to be the best projectile to bombard the nucleus ?

Compare the effect of increasing the temperature of good conductors and semi conductors.
Draw the circuit diagram of a full wave rectifier.

Define transducer and give one example of the same.

Name any two ways in which waves of electromagnetic radiations propagate through space with their
frequency range ?

SECTION - C

Questions, 33 to 48 are short answer type questions, each carries TWO mark. 32

Explain the behaviour of an electric dipole in an uniform electric field.

Explain electro-static shielding with an example.

derive equation for the resultant capacitance of series combination of capacitors in series combination.
Explain contact potential with the help of necessary diagrams.

Derive the expression for magnetic field at a point on the axis of the circular ring

carrying current.

Or
State and explain Biot-Savart’s law.
What are eddy currents ? How can they be reduced? State two uses of eddy currents.
OR

State the difference between peltier effect and Joule effect

Represent impedance of an A.C. circuit having L-C-R in series in a complex plane and obtain the
expression for the magnitude of impedance and phase difference.

Explain the working of an L-C circuit with the help of a diagram.

Obtain the relation between u, v and R in case of refraction at spherically curved surface.

Describe with a ray diagram, the construction and working of cassegrain’s reflecting telescope.
Derive the expression for resultant intensity of light on a screen produced due to interference of two
light rays.

Give Einstein’s explanation for photo electric effect and also derive necessary equations.

Consider the wave nature of an electron and show that angular momentum of an electron movingin a
circular orbit of radius ‘r’ is quantized.

OR

Explain the characteristic X-ray spectrum.

Explain the avalanche effect.

Explain the working of a transistor as an amplifier, with the help of a circuit diagram.

Write about Amplitude shift keying and frequency shift keying techniques in transmission of digital
information.

SECTION -D
Answer the questions , 49 to 60 as directed. Each carries THREE mark. 36

A charge of 4 x 10-8 C is uniformly distributed all over the surface of a sphere of radius 1 cm. Another
hollow sphere of radius 5 cm is concentric with the small sphere. Find the intensity of electric field at a
distance of 2 cm from the centre. K=9x 10° S
OR
The surface charge density of a very large surface is equal to -3.0 x 10° Cm™. From what
distance should an electron of 150 eV energy be projected towards the plane so that its
velocity becomes zero on reaching the plane? Charge on an electron is 1.6 x 10° C,
1leV=1.6x10"J, £,=9x10™"* Sl

A drop of water (spherically shaped ) has 3 x 10-10 C amount of charge residing on it. 500 V electric

potential exists on its surface. Calculate the radius of this drop. Two such drops (having identical charge
and radius ) combine to form a drop. Calculate the electric potential on the surface of the new drop.

Page 39 of 56



NAVRACHANA VIDYANI VIDYALAYA SAMPLE PAPERS 2010-11

50. A thin layer of 0.001 cm of copper is to be deposited on a plate of copper of 10 cm? through electrolysis.
Calculate the amount of energy used if a battery of 12 V is connected. Density of copper = 9 gcm™>,
electrochemical equivalent of copper = 0.0003 g mol ™.

51. A very long straight wire is carrying a current of 10A. If an electron is moving parallel to this wirein a
direction opposite to the current at a distance of 20 cm from the wire, with a velocity of 5 x 105 ms-1,
find the force of attraction experienced by the electron.

(e=1.6x10-19C, po=4x107)

52. 20 A current is passing through the winding of a Rowland ring. The number of turns on the ring is 400
and the average circumference of the ring is 40 cm. In this situation the magnetic field produced in the
material inside the ring is 10 T. Find : (i) magnetic intensity (ii) magnetization intensity (iii) magnetic
suseptibitility .

53. A110V, 10 W lamp has to be connected with an a.c. source of 220 V and 50 Hz. Calculate the
inductance of the choke coil to be connected in series with it.
OR
The series combination of R(Q) and capacitor C(F) is connected to an a.c. source of V volts and angular
frequency w . If the angular frequency is reduced to w/3, the current is found to be reduced to one-
half without changing the value of the voltage. Determine the ratio of the capacitive reactance and the
resistance.

54. 15% of the total energy of a 100 W bulb is converted into visible light. Calculate the average intensity at
a spherical surface which is at a distance of 2 m from the bulb. Consider the bulb to be a point source
and let the medium be isotropic.

55. The distance between two narrow linear sources is 0.7 mm. If the fourth dark fringe is at a distance 3
mm from the central bright fringe in the interference pattern produced by them on a screen placed at
the distance of 1 m from the sources, find the wavelength of monochromatic light.

OR
For a thin lens object distance is 20 cm and image distance is 51 cm. If the image is
formed on the other side of the lens. Find,
(i)Focal length of the lens (ii) Type of the lens (iii) Type of the image
(iv) Lateral magnification

56. Find the de Broglie wavelength of an atom of nitrogen gas at 300 K. Mass of nitrogen atom is 4.7 x 10%
kg

57. Calculate the maximum wavelength of Balmer series in the hydrogen spectrum. Calculate the
corresponding wave number. Rydberg constant = 1.097 x 10’ m™

58. At a specific time, the rate of radioactive decay of a substance is 8000 decay/s. At that time the
undecayed number of nuclei is 8 x 10”. Find the decay constant and the half life.

59. A change of 0.02V takes place between the base and emitter when an input signal is connected to the
CE transistor amplifier. As a result, 20 A change takes place in the base current and a change of 2mA
takes place in the collector current. Calculate the
(i) Input resistance (ii) A.C. current gain (iii) transconductance
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10.

11.

12.

13.

14.

15.

16.

17.
18.
19.
20.
21.
22.
23.
24.
25.
26.
27.

PHYSICS-III

Question Nos. 1 to 16 are multiple choice questions. Each carries one mark. Choose the correct
answer (a or b or c or d) from the given alternative response and write it. 16

There exists an electric field of 100 N/C along Z-direction. The flux passing through a square of 20 cm
sides placed on XY-plane inside the electric field is .
(a) 1.0 Nm?/C (b) 2.0 Vm (c) 10 Vm (d) 4.0 Nm?/C

A 4 uF capacitor is charged up to 100 V. The plates of the capacitor are then connected with a
conducting wire. How much heat will be generated in the above situation ?

(@)o.2) (b) 0.02) (c)0.002) (d)2)

If 5.0 x 10° Q is the resistance of a person’s wet hand, then __ potential difference will generate a
fatal current of 1.0 mA.

(a) 50V (b)110V (c)230V (d) 220V

A wire of 2m is bent in the form of a circular loop. The magnetic moment of the loop when 1 A current
flows through it is Am? .

(a)2m (b) 1/m (c)m/2 (d) /4

Thermoelectric constants of a thermocouple are a and B. Thermoelectric power for this thermocouple
at inversion temperature is

(a) B (b) o/B ©-a (d) —a/B

With reference to earth, the angle of dipism/2radat

(a) equator (b) 45° North latitude

(c) Magnetic poles of the earth (d) Geographic poles of the Earth

An inductor stores energy in its .

(a) electric field (b) magnetic field (c) conducting wire (d) electric and magnetic field
The real power in an A.C. circuit containing only inductor is equal to W.

(a) % LI? (b) 2L1% (c) % L (d) zero

If the relative permeability and dielectric constant of given medium are equal to W, and K respectively,
then the refractive index of the medium is equal to

(a) 1/V K (b) Ve, (c) Vo & (d) VK

Focal length of the lens of the eye is changed by

(a) cornea (b) ciliary muscles (c) retina (d) lens
Which of the following phenomena is not possible for sound ?

(a) interference (b) diffraction (c) polarization (d) reflection

The wavelength of the first line of Lyman series is A. The wavelength of the first line in Balmer series is

(a) (27/5) A (b) (5/27) A (c) (9/2) A (d) (2/5)A
Cathode rays are
(a) the atoms moving towards the cathode. (b) electromagnetic waves.

(c) negative ions travelling from cathode to anode.  (d) electrons emitted by cathode and travelling
towards anode.

1mCi=____ Becquerel.
(a) 3.7 x 10* (b) 3.7 x 10 (c)3.7 (d)3.7x 107

The Boolean expression for NOR gate is .
(@Q)y=A+B (b)y=A-B (c) y=A+B (dy=A+B

The communication by a modem is of type.
(a) simplex (b) full duplex (c) half duplex (d) double duplex
SECTION -B

Questions , 17 to 32 are very short questions, each carrying ONE mark.
State Coulomb’s inverse square law.

What is polar dielectric ?

What is thermopile ?

What is gyro-magnetic ratio ?

What are diamagnetic substances ? Give one example of it.

What is ‘ Back emf’ ?

What is Rayleigh’s scattering ?

What is polarized light ?

On which factors does the threshold frequency of a metal depend ?
Which type of defect in vision is called Near sightedness ? Name the lens used to correct it ?
What is stimulated emission ?
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28
29

30.
31.
32.

33.
34.

35.

36.
37.
38.
39.

40.
41.
42.
43.
44,
45.
46.
47.
48.

49.

50.

51.

52.

53.

54,

. What are moderators ? Name the materials that are used as moderators.
. Draw the circuit diagram of a CE amplifier.
Write the truth table for OR gate.
Define critical frequency.
State any one necessity of modulation in communication.
SECTION - C

Questions, 33 to 48 are short answer type questions, each carries TWO mark. 32

Obtain the formula of force on a point charge q due to uniform surface charge distribution.

Define electric potential and obtain expression of electric potential at a point in the electric field of a
given charge.

Using Ug = % CV?, obtain the equation for energy density in terms of electric field between plates of
charged capacitor.

Explain Peltier effect and define peltier emf.

Obtain the formula for force acting on a charge moving in a Magnetic and electric field.

Explain mutual inductance with the help of a diagram and hence define it.

Derive the differential equation of charge Q for the circuit containing L,Cand R in series. Applied A.C
circuit voltage, V = V,, cos wt.

Write the principle of transformer. Obtain the expression N, : Ny =E, : E;

Obtain the Gauss formula for concave mirror.

Obtain the condition for first order minimum for Fraunhoffer diffraction by a single slit.

Derive the general form of Snell’s Law.

Write four characteristics of photon.

Write the limitations of Bohr model.

Explain the working of a zener diode in voltage regulator.

With the help of a diagram explain two types of electric current in a semiconductor.

Derive the formula d = V2hr for space wave transmission.
SECTION -D
Answer the questions , 49 to 60 as directed. Each carries THREE mark. 36

Two spheres having same radius and mass are suspended by two strings of equal length from the same
point, in such a way that their surfaces touch other. On depositing total 4x10’ C charge on them, they
repel each other in such a way that in equilibrium the angle between their strings become 60°.If the
distance from the point of suspension and to the centre of the sphere is 20 cm, find the mass of each
sphere. K= 9x10° SI and g=10 ms>.

OR
Q amount of electric charge is residing on a conducting sphere having radius equal to Ry. This sphere is
connected to another conducting sphere of radius R, by a conducting wire. Calculate the electric charge
on each of the spheres. The two spheres are separated by a large distance.

The tungsten filament of the bulb has resistance equal to 18 Q at 20° C temperature . A current of
0.185 A flows, when 30 V is connected to it. If a = 4.5 x 10> K™ for a tungsten, then find the temperature
of the filament.

On passing some current through a silver voltameter for 10% s, 1.118 gm silver collects on its cathode.
An ammeter connected in series shows 0.9 Amp. If the electrochemical equivalent of silveris 1.118 x 10°
6 kgC'l, find the error in the ammeter reading.

A proton and a deuteron having the same kinetic energies enter a region of uniform magnetic field.
Deuteron’s mass is twice that of a proton. Calculate the ratio of the radii of their resulting circular
paths.

The region inside a current carrying toroidal winding is filled with tungsten of susceptibility 6.8 x 10™.
What is the percentage increase in the magnetic field in presence of the material with respect to the
magnetic field without it ?

Two long solenoids are of equal length | and the smaller solenoid having a cross-sectional area A is
placed within the larger solenoid in such a way that their axes coincide. Find the mutual inductance of
the system.

OR
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55.

56.

57.

58.

59.

60.

Find the equivalent inductance of two inductors connected in parallel with the help of an appropriate
dc circuit.

A1000 W bulb is kept at the centre of a spherical surface and is at a distance of 10m from the surface.
Calculate the force acting on the surface of the sphere by the electromagnetic waves, along with E,, B,
and |. Take the working efficiency of the bulb as 2.5 % and consider it as a point source. Also calculate
energy density on the surface.
Here, E, : maximum electric field strength

Bo: maximum magnetic field strength

| :intensity of the waves.

€, =8.85x10™° Sl and c=3.0x10° m/s

A fish is at some depth in a lake. It is at horizontal distance R = 1.5 m from the edge of the lake. If it is
just able to see a tree on the edge of the lake what is it’s depth ?

Or
The ratio of intensity of light emerging from two sources is a. For the interference pattern produced by
them, prove that,

Consider the radius of a nucleus to be 10> m. If and electron is assumed to be in such nucleus, what
will be its wavelength ?
Mass of electron =9.1 x 10! kg; h=6.6 x 103% Js

Calculate the quantum number for which the radius of the orbit of electron in Be** would be equal to
that for the ground state of electron in a hydrogen atom. Also compare the energy of the two states.

Half life of a radioactive element is 0.693 s. How much time will it take for the decay of 80 % of this
substance ?

Two amplifier circuits are connected in series. The voltage gain of the first amplifier is equal to 15 and
that of the second amplifier is equal to 10. If a 10 mV signal is applied at the input of the amplifier,
then what will be the output signal ?

OR

The density of electron hole pair in a pure semiconductor at 300K temperature is equal to 1.5 x 10** m"
3. The number density of the majority charge carriers becomes equal to 4.5 x 102 m>on adding trivalent
impurity atoms. What will be the number density of the minority charge carriers in the above sample ?
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10.
11.
12.
13.
14.
15.
16.
17.
18.
19.
20.

21

29.
30.

31

40.

41.

BIOLOGY-I
What is RQ? Why RQ of organic acids is more than 1?
Differentiate between Thrombocytes and Monocytes.
Where are the respiratory centres located in the brain? Give the role of any 2.
Which part of brain maintains homeostasis in internal environment? Write 2 of its other functions.
A farmer wants to develop seedless grapes in his orchard. Can you suggest him the ways to develop to
them.
Invagination of primitive streak fails to occur. What will be the fate of developing foetus?
Diagrammatically show the role of rubisco in Calvin cycle and photorespiration
What are the effects of senescence on brain and heart in man?
What are immunomodulators? Give their types.
What is the full form of ELISA test? Why this test is to be repeated every 6 months?
Why GM foods are considered controversial by some environment enthusiasts?
Name any 4 mental behavioural problems.
Give any 2 reasons for threat to biodiversity.
Write the criteria of essential mineral nutrients (any 2)
Give the source, place of action and the products formed by the enzyme Peptidase
What are the diseases caused due to metabolic disorders in urine formation? Give the reason.
Define 2 main reasons for deafness of the ear.
Describe the respiration in earthworm.
Give the names and role of digestive hormones.
What is biomagnification? Which level of organisms are most affected by it and Why?

. Explain in detail any 2 methods of soil conservation.
22.
23.
24.
25.
26.
27.
28.

Explain any 2 kinds of growth in animals giving examples

How osmoregulation takes place in aquatic animals?

Which patients need artificial pace maker? Where it is placed in the body? How it works?

How can you remove seed dormancy?

Name a bone disorder caused due to auto immune responses? What happens in it?

Which features are considered susceptible to extinction of organisms?

The hormone secreted by this gland encourages absorption of Na+ and K+ and maintains balance of
these ions in our body. Name the gland and the hormone. Also name the other hormone secreted by this
gland with one function of it.

Write in detail about the anaerobic respiration in plants and animals.

Describe reticular and limbic systems.

. In which technique radioactive C and O are used for diagnosis? Explain about that method.
32.
33.
34.
35.
36.
37.
38.
39.

How can you control vehicular pollution? OR

How can you control industrial pollution?

Explain in detail the process of decomposition.

Draw a flow chart of photorespiration.

Explain circulatory system in cockroach.

Discuss in detail uterine cycle.

Explain the mode of action of peptide hormone with diagram.

Explain with the flow chart photophosphorylation. OR

Describe with the flow chart oxidative phosphosphorylation.

Draw neat and labeled diagram of LS of human brain. Describe structure and functions of different

regions of brain stem.

Draw and explain the structure of male reproductive system in man.
Write a note on antibody mediated immunity. OR

Write the causes, symptoms and treatment of cancer.
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COMPUTER-I
Q: Choose the correct alternative from the given alternatives:

1. Which attribute of radio button specifies that it is to be shown selected from the beginning?
a) selected b) checked c) check d) default

2. To create an application which allows opening the image/image path after browsing for the file
name, which attribute of <input> element is used?
a) type=file b) type=button c) type=img d) type=src

3. For the code <input type=textbox name=text1 value=text box>, what is displayed in the textbox on
the browser window?

a) text1 b) text c) textbox d) Nothing will be shown
4. Which of the following is the correct property to define types of fonts in CSS?
a) font b) font-face c) font-family d) font-type
5. Which of the following are the possible values for the clear property of label selector?
a) right b) both c) none d) All of these
6. Which of the following is used to depict ‘not equal to’ in JavaScript?
a) <> b) # c)!= d) NOT
7. Which event would occur if the mouse has moved over the element in a JavaScript program?
a) onmouseover b) onMouseover c) ONMOUSEOVER d) All of these
8. Which of the following is an invalid way to use variable in JavaScript?
a) vara, b b) var a=10; c)var a=10; b=10;  d) None of these
9. Which function is used to define that the cursor should be placed into the textbox?
a) onfocus( ) b) focus() c¢) gotfocus( ) d) All of these
10. Which of the following is used to concatenate strings in JavaScript?
a)+ b) & c) && d);
11. What is meant by GPL?
a) Generic Private Legislature b) General Proprietary Legislature
c) Generic Proprietary License d) None of these
12. Which of the following rules do not apply to open source softwares?
a) availability of source code b) royalty payment on redistribution
¢) modification of source code d) non-discrimination against persons, regions
13. What is meant by ‘integrity of software’ in open source software?
a) Overwriting the original source code b) Generating a new source code with license
c) Derived work to carry different name/version d) None of these
14. Which of the following are/is operating system(s) created under open source environment?
a) FreeRTOS b) FreeBSD c) FreeDOS d) All of these
15. Which is one of the most successful open source browser till date?
a) OpenSolaris b) Inferno ¢) Minix d) None of these
16. Which of the following open source office suite works only on Windows OS?
a) GNOME office b) SoftMaker Office ¢) NeoOffice d) KOffice
17. Which version of OpenOffice is currently in use?
a) 1x b) 1.5x c) 2x d) 3x
18. LGPL software can be used for which of the following purposes?
a) Commercial b) Educational c) Domestic d) All of these
19. What is the Open Office spreadsheet application called?
a) Base b) GBase c) KBase d) None of these
20. Which of the following application would allow creating queries and reports in Open Office?
a) gedit b) Calc c) HSQL d) None of these
21. Which of the following application would allow creating flowcharts in Open Office?
a) Draw b) Math c) Paint d) None of these
22. Which of the following is the most used Open Source Web Server?
a) AOLServer b) Apache HTTP c) SeaMonkey d) Zope
23. What is IDE?
a) Integration of Database Environment b) International Database Environment
c) Integrated Development Environment d) Integration of Database Environment
24. Which of the following is a programming/scripting language?
a) PHP b) Python c) Perl d) All of these
25. Which of the following is a open source image editor?
a) GIMP b) KIMP c) IMP d) GKIMP
26. Who was the pioneer of Linux OS?
a) Linus Torvalds b) Minix Torvalds c) Richard Torvalds d) Linus Stallman
27. What is the main directory in Linux called as?
a) bin b) boot c) root d) usr
28. What is the attaching of any hard drive to the Linux system called?
a) loading b) plugging ¢) mounting d) logging
29. The file system used in Unix/Linux is called file system.
a) complex b) simplified c) unified d) multiplied
30. Which directory contains unix commands?
a) /lib b) /home c) /boot d) /bin

31. Which of the following directory shows the various drives/disks attached to the system?
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32.

33.

34.

35.

36.

37.

38.

39.

40.

41.

42.

43.

44,

45.

46.

47.

48.

49.

50.

51.

52.

53.

54.

55.

56.

57.

58.

59.

60.

61.

62.

63.

a) /mnt b) /dev c) /boot d) tmp

Which directory allows recovery from crash in Linux?

a) /crash b) /lost+found c) /proc d) /etc

What is meant by LILO?

a) Last in Last out b) Last in Load out  c) Linux Loader d) None of these
Which is the default desktop given to the user in RedHat Linux?

a) GNOME b) KDE c) KNOME d) GDE

What is the file manager called in Linux?

a) Explorer b) Browser c¢) Nautilus d) All of these
Which of the following is an application similar to Ms Outlook?

a) Evolution b) Nautilus c¢) Mail-C d) IRC

Which of the following is used to compress files in Linux?

a) File Manager b) Tar Manager c) Zip Manager d) Archive Manager
Using the above software (GUI) what will be the extension of the compressed file?

a) .zip b) .gz.tar c) .tar.gz d) .gz

Which of the following file formats can be played directly on the built-in players in Linux?

a) .midi b) .aiff c) .mp3 d) .mpg4

Which of the following is the Indian GNU/Linux distribution?

a) BOSS b) NRCFOSS c) FOSS d) C-DAC

Which of the following shows the administrator prompt in Unix/Linux?

a) # b) $ c)@ d) Both (a) & (b)
Which of the following is the command line interface of Linux that accepts/issues commands?
a) File system b) Shell c) Kernel d) Terminal

Which was the earliest shell in Unix OS?

a) C shell b) Bourne Shell c) T Shell d) None of these
Which of the following shell had the combined features of Bourne shell and C shell?

a) Bash b) Korn c) Tcsh d) None of these
$SHELL is an example of .

a) default variable b) built-n variable c) system variable  d) environment variable
Which command at the command prompt will allow you change you default shell from bash to ¢
shell?

a) $SHELL b) /bin/bash c) csh d) cd $SHELL
Using which of the following are options given to alter the behavior of the commands in Linux?
a) - b) - - c)” d$

Which command is used to access the built-in help in Linux?

a) help b) save c) man d) F1

What should be the command to get the current month’s calendar at Linux command prompt?
a) cal b) calendar c) cal 2009 d) calendar 2009
Which of the following format is used to display the date in mm/dd/yy format with the date
command?

a) date +%d b) date +%D c) date +"%m:%d:%y” d) Both (b) & (c)
What will be the output of echo 4+5|bc?

a) 9 b) 4+5 c) 4+5|bc d) Error

Which of the following option is used to invoke the command line calculator with the standard math
libraries?

a) calc b) calc -lib c) calc -l d) None of these
Which of the following command is used to find the natural logarithm of 1237

a) In(123) b) 1(123) c) log(123) d) None of these
Which command is used to change the login password?

a) password b) passwd c) pwd d) paswd

Which of the following command will display your default working directory?

a) pwd b) /root c) SHOME d) $PATH

What does the following command do: cp hello help health new?

a) Create multiple copies of the file hello b) Merge the files hello, help, health into new file

c) Copy hello file to help, health, new directories  d) Copy hello, help, health files to new directory
Which command is used to rename files in Linux?

a) cat b) mv c) ren d) rename

What will the following command do: mv get1 get2 get3?

a) copy the directories get1, get2toget 3  b) move the files get1, get2 to get3 directory

c) rename directories get1 and get2 to get3 d) move the directories get1, get2 into directory get3

./home/Vidyani/std12/ch12 is an example of path.

a) relative b) absolute c) environmental d) parent

You are in Vidyani directory. Which command can be used to move the file ‘hello’ to the sub-
directory ch12?

a) mv hello ch12 b) cut hello ch12 c) cp hello .. d) mv hello ./std12/ch12
Which command is used to create an exact image of a file on the disk?

a)cp b)Is —c c)cp-e d) copy

Which command is used to remove an empty directory?

a) rmdir b) delete c) remove d)yrm-d

Which command displays the line count of a file ‘long’?
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a) wc long b) wec -l long c) wc —line long d) wc —wcl long
Which command is used to view the file permissions of the file ‘long’?

a)ls -l long b) Is —p long c) cat long d) chmod long
What does the following permission depict:: -rw-rw-rw- little?

a) little is a directory b) little is a file c) file is read only d) None of these
Which of the following command is used to make a file ‘kit’ also executable for all?

a) chmod a+x b) chmod a=x c) chmod ugo=x d) chmod a-x
Which command is used to uncompress a zipped file ‘kit'?

a) gzip —u kit b) gzip —d kit c) gunzip kit d) None of these
Which option is used with cut command to specify the delimiter used in the file?

a)— b) —d c)—f d) -t

Which of the following command will give the same output as : whoami?

a) wholcut —t “:* — 1 b) who|cut —d “:“ —c 1 ¢) whol|cut -d ““ — 1 d) who|cut —c “|“ —d 1
Which command is used for pattern searching?

a)tr b) grep C) uniq d) paste

Which of the following are editors where shell scripts are written?

a) vim b) vedit c) edit d) kedit

Which sign displays the unused lines in vi editor?

a) - b) c)~ d) _

What is the default mode of vi editor?

a) command mode b) execute mode c¢) colon mode d) None of these
How do you invoke the insert mode of vi editor?

a) Press i b) Press insert key  c) Press Esc d) All of these
What does ‘A’ command do in insert mode?

a) Appends text at the end of current line b) Appends text after the current cursor position

c) Appends text at the beginning of current line d) Edits selected text
Which command is used to replace a single character under cursor with another character?

a)R b)r c)s d)S

Which command is used to replace the entire line?

a)R b)r c)s d)S

Which command takes you ex-command mode?

a)Esc: b) : c)Escc d) Esc x

Which command is used to exit the editing mode without making changes to file?

a) .q b) :q! C) X d) :w

Which command is used to save the file and quit the editing mode?

a) :wq b) :x c) :w d) Both (a) & (b)
Which of the following command is used to run the script one.sh?

a) sh one.sh b) x one.sh c) chmod one.sh d) All of these
Pressing which key on the keyboard allows deleting the character on the cursor position?
a)d b) x c) Esc x d) Escd

Which key is used to move the cursor to the left direction?

a)h b) k c)l d)j

Which of the following is used as assignment operator in shell scripting?

a) == b) := c)= d) -eq

Which of the following option is valid with echo command?

a) - b) —s c)— d) -n

Which of the following is used to check the exit status of a command?

a) for construct b) while construct c) if construct d) All of these
‘cmp’ command is used on .

a) numbers b) files c) strings d) directories
How is the if construct ended?

a) using endif b) using [] ¢) using fi d) Using fidne
How is ‘not equal to’ used in if construct?

a)<> b) I= c) # d) None of these
Which of the following is used to check whether the file exists and has size>0 in if construct?
a)-s b) —f C)—sz d) fs

How is the logical operator ‘AND’ used in shell script?

a) + b) && c) AND d) -a

Which of the following is used to check whether the length of string str is greater than zero?
a)—s str b) —z str C) —n str d) None of these
On the encounter of the case statement starts checking the next condition.
a);; b) ; c) break d)*

Using which of the following is unexpected input handled in case statement?

a) #) b) *) c)?) d) %)

Which of the following symbol indicates string beginning with ‘m’?

a)$m b) m$ c) m d) m”

Which command is used to accept a filename from the user in the shell script?

a) input b) read c) enter d) scan

What is the output of : a=a + 1, where a is a variable storing number 10 in a shell script?
a)a=a +1 b)a+1 c) 11 d) Error
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98. Which of the following is used to get the exit status of a command?

a) $* b) $$ c) $? d) $#

99. How is do statement closed in a shell script?
a) done b) donefi c) enod d) od

100. Which of the following loop construct allows specifying a list of values in its statement?
a)do b) until c) while d) for
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COMPUTER-II
What are the special purpose text that are used to create webpages called in HTML?
a) tags b) angular bracket c) elements d) All of these
Which of the following is/are the part(s) of ‘Tags’ in HTML?
a) values b) properties c) elements d) All of these
Which of the following is usually used to send data to the server or retrieve information?
a) JavaScript b) forms c) frames d) None of these
Into how many parts can a form be divided?
a) 4 b) 3 c)2 d) 5
Which of the following allow the user to enter data?
a) control elements b) form container ¢) input controls d) Both (a) &(c)
Which of the following is not a type of form control element?
a) File select button b) select menu c) submit button d) None of these
Which of the following attribute uniquely identifies a control on the form?
a) size b) name c) value d) type
What will be displayed as the output of the following: <input type=submit>?
a) a button with ‘Submit’ displayed b) a button with ‘Submit Query’ displayed
¢) a textbox with ‘Submit’ displayed d) None of these
What interprets a JavaScript code in HTML?
a) compiler b) interpreter c) web browser d) server
Which of the following is used to prompt the user to enter his details using JavaScript?
a) inputbox b) prompt c) alert d) confirm
Which of the following is used to concatenate strings in JavaScript?
a) ‘& b) ‘+’ c) ‘&& d) AND
Which of the following is used as a comment tag in HTML?
a)/l b) <!-- --> c) <-- l--> d)*/ I
Which of the following is the correct way to using the ‘script’ element?
a) <script>..</script> b) <Script>..</Script> ¢) <SCRIPT>..</SCRIPT>d) All of these

If form1’ is the name of the form and ‘no1’ the name of a textbox, which of the following is the
correct code to clear the textbox of its contents?

a) textbox.clear b) no1.clear c) form1.no.clear d) None of these
‘addNumber()’ is an example of which type of function?

a) Built-in b) User-defined c) Modular d) None of these
parseFloat( ) takes text as input and returns number.

a) floating point b) decimal c) real d) exponent
FAQ stands for :

a) Frequently Asked Questions b) Few Asked Questions

c) Frequently Answered Questions d) Few Answered Questions

Which of the following holds true for the ‘Browser Compatibility’ feature of a website?

a) Content should be precise, concise and brief

b) image file formats used in website should open in all browsers

c¢) customer forum to share their experience

d) All of these

‘ebay.com’ is an ecommerce site. Which of the following would be the most appropriate structure of
the website?

a) Hierarchical b) Catalog c) Linear d) None of these
Which of the following structures provide a navigation bar to allow the user to move to any section
directly?

a) Hierarchical b) Catalog c) Linear d) Tutorial

A sitemap of a website is an example of structure.

a) Hierarchical b) Catalog c¢) Linear d) Tutorial

Which of the following means the layout of the webpage?

a) Web layout b) Site layout c) Site Template d) Page Template
Which of the following the popular image file formats used on the web pages?

a) BMP b) TIFF c) GIF d) All of these
Microsoft Office Publisher can be used for which of the following applications?

a) Catalogs b) visiting cards c) certificates d) All of these

Which of the following are valid options available while creating web sites and email using
Publisher?

a) Product Services b) Professional Sales c) 3-Page Web site  d) All of these

To change the logo displayed on the web page, one should select the old logo and then click on
icon.

a) magic wand b) magic slate ¢) magic hand d) magic select

More templates can be downloaded from which of the following site to satisfy the web designing
requirements?

a) www.msoffice2003.com b) www.microsoft.com

c) www.mspublisher2003.com d) www.mspub.com

Which of the following fields use the concept of e-commerce?

a) net-banking b) auction of goods ) goods trading d) All of these

For which of the following purposes is amazon.com famous?
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a) selling books b) selling watches c) selling IT goods  d) selling auction goods
30. Which of the following website provides live auction of goods?
a) amazon.com b) sellonline.com c) auctiononline.com d) ebay.com
31. Which of the following transaction cannot be performed through net banking?
a) Transferring money b) Balance Inquiry  c) Withdrawal of money d) Online purchases
32. Which of the following is not a valid type of e-commerce business model?
a) B2B b) C2B c) C2C d) B2C
33. Which of the following come under G2B?
a) income tax returns forms b) birth certificates
c) welfare schemes d) All of these
34. Which of the following network is developed by the Government of Gujarat as a part of G2C?
a) GSWAN b) GEDI c) GSMAN d) GSEB
35. What is important before adding an item into the shopping cart?
a) registering to the website b) checking your bank balance
c) surfing for the item on different sites d) All of these
36. What is VPP?
a) Very Precious Parcel b) Value Precious Parcel
c) Value Payable Parcel d) Visa Payable Parcel
37. When is VPP sent to the purchaser?
a) When paid through credit card b) When paid through smart card
¢) When paid through cash d) When paid through debit card
38. To connect your website to an e-commerce database, you should use which of the following?
a) ASP b) XML c) Java d) LINUS
39. What is JSP?
a) Java Servelets b) Java Server Pages c) Java Script Pages d) Java Script Problems
40. PHP stands for .
a) Preprocessor Hypertext b) Pre Hypertext Processor
c) Hypertext Preprocessor d) Hypertext Processor
41. ‘Open Source’ term means .
a) Source code is accessible to all b) Source code is available free of charge
c¢) Source code cannot work on all platforms d) Programs developed by specialized people
42. Which of the following is an application of open source technology?
a) Windows Server b) HTTP Server c) Apache Server d) HTTPx Server
43. Which of the following is/are open source programming/scripting language(s)?
a) Python b) Perl c) Both (a) & (b) d) PostgreSQL
44. Which of the following is an open source Linux desktop environment?
a) GIMP b) GNOME c) PHP d) AJAX
45. Which of the following is an open source mail client?
a) gmail b) moodle c) plone d) thunderbird
46. What is NetBeans IDE used for?
a) Creating windows b) Creating menus  c) Both (a) & (b) d) None of these
47. NetBeans IDE supports which of the following?
a) Ajax b) Java c) C++ d) All of these
48. BOSS stands for :
a) Business Open Source Software b) Business Operating System Solutions
c) Bharat Open Source Software d) Bharat Operating System Solutions
49. The Indian GNU/Linux is presently localized in which of the following languages?
a) Hindi & Telugu b) Hindi & Tamil c) Tamil & Gujarati  d) None of these
50. Which of the following is the correct release of Indian GNU/Linux?
a) Sarang b) Anand c) Tarang d) All of these
51. How do you make ch-8.tar.gz file compatible to Windows WinZip software?
a) change extension to .zip b) change extension to .gz
c) change the extension to .tar.gz.zip d) it is not possible in Linux to do so
52. What is ‘Evolution’?
a) mail-client software b) internet setting software
c¢) audio player software d) movie player software
53. Which of the following option allowing finding files/folders in Linux?
a) Find b) Search for files c) Search d) Find and Display
54. Which of the following operation is possible in Nautilus File Manager?
a) create files b) move files c) delete directories d) All of these
55. Find and Replace option appears in which menu in Open Office Writer?
a) Edit b) View c) File d) Tools
56. Spell check option appears in menu in Writer.
a) Edit b) View c) File d) Tools

57. The formatting toolbar in Open Office shows relevant tools in response to the cursor’s current
position or selection. What is such a bar called?

a) cursor sensitive b) context sensitive  c) tool sensitive d) data sensitive
58. What is the shortcut key to create a new Writer file?
a) Ctrl + N b) Shift + N c) Ctrl + Shift + N d) Ctrl + Alt + N

59. The Navigator displays all objects contained in a document. How do you display the Navigator?
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a) File|Navigator b) Edit|Navigator c) Tools|Navigator  d) Window|Navigator
A PDF file of the existing Writer file can be created by which of the following options?

a) File>Save As>PDF b) File>Export as PDF

c) Clicking on Export Directly as PDF icon d) Both (b) & (c)

What is the default extension of a Writer file?

a) .odt b) .odf c) .odw d) .doc

Which of the following are valid views in Writer?

a) Zoom b) Page Layout c) Outline d) All of these

How do you enable creating presentation through Wizard every time you open Impress?

a) File >Wizard > Presentation b) Tools>Wizard > Presentation

c) File >New >Wizard d) Insert > New >Wizard

Which view of Impress allows adding text and graphics to the slides?

a) Slide View b) Normal View c) Both (a) & (b) d) None of these
How many rows does Calc have?

a) 65536 b) 16777216 c) 256 d) Unlimited

Which of the following allows creating fill series in Calc?

a) Edit >New—>Series b) Edit->Fill>Series c) Insert>New->Series d) Insert >Fill>Series
Which of the following is/are valid series type(s) in Calc?

a) Growth b) Direction c) Exponent d) Both (a) & (c)
What will be the correct formula to round off the number 190.23 to zero decimal places in Calc?
a) =trunc(190.23,0) b) =round(190.23,0) c) =trunc(190.23:0) d) =round(190.23;0)

You have created an Ms Excel file called charts.xls in Windows OS. You take this file on an external
storage device and transfer it on Linux OS. How will you open this file?

a) change the file extension from .xls to .ods

b) convert the file to pdf and then only can you open the file

c) open Calc and open the file

d) The file cannot be opened at all

Into how many categories are the formulas in Calc divided into?

a) 10 b) 11 c) 12 d) 15

Under which category does the ‘frequency’ function appear in Calc?

a) Logical b) Mathematical c) Statistical d) Array

The place where the commands are executed in Linux is called .

a) administrator prompt b) user prompt c¢) console prompt d) command prompt
Which of the following is a command language interpreter that accepts/issues commands?
a) Kernel b) Shell c) Prompt d) Terminal
Which type of shell is given by ‘sh’?

a) Korn b) Bourne c)C d) None of these
Which of the following command gives the default shell of your system?

a) /bin/bash b) SHOME c) #Shell d) $SHELL
Which command will temporarily change your default shell to ‘C’ shell?

a) #shell c b) ctrl + d csh c) csh d) $csh

How do you exit the online help given by man pages?

a) Ctrl+Z b) Ctrl + K c) Ctrl +d d) Ctrl + m
Which of the following command will only display the calendar of December 20107?

a) cal 2010 b) cal Dec 2010 c) cal 12 2010 d) All of these
What is the last field of the ‘date’ command?

a) time zone b) year c) date d) time

Which of the following format specifier is used to display the date in mm/dd/yy format using the date
command?

a) %D b) %d c) %B d) %b
How many minimum number of arguments are needed by the cp command?
a)3 b) 2 c)4 d) 1

What does the following command do: cp good better best luck?

a) copy contents of file good to files better, best and luck

b) copy the contents of files good and better to files best and luck

c) copy the contents of files good, better and best to file luck

d) None of these

Which of the following is used with ‘more’ command to view the previous pages of a file on the
screen?

a) enter key b) b c)f d) Both (a) & (b)
Which of the following command gives the file size?

a) more b) size c) wc d) show

What does the ‘hyphen’ in the following indicate: -rwxrwxrw-?

a) file permission is missing b) not a directory c) Both (a) & (b) d) None of these
Which of the following can be performed on a file with the following: -r-xr--r--?

a) delete the file b) edit c¢) append data d) None of these
Which command is used to remove an external storage device safely?

a) mount b) umount ¢) unmount d) remove
Which mode of vi editor allows the entry of commands to manipulate text?

a) colon mode b) ex mode c) insert mode d) None of these
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89. Which command allows inserting text in a new line above the current cursor position in vi editor?

a)A b) O c)R d)S
90. Which command allows inserting text from the beginning of a line in vi editor?

a)l b) O c)A d)i
91. Which command replaces characters till Esc is hit in vi editor?

a)r b) R c)s d)S
92. Which command is used to replace an entire line in vi editor?

a)r b) R c)s d)S

93. Which command is used to exit the editing mode when no changes are made in a file in vi editor
after pressing Esc?

a) :w b) :x c):q d) :q!
94. You want to execute your script file s1.sh. Which of the following command can be used to do so?
a) ./ s1.sh b) ex s1.sh c) run s1.sh d) None of these
95. What is the exit status when a command has been executed successfully?
a)o b) 1 c) true d) false
96. Which command is used to compare the contents of two files using if construct in shell scripting?
a) —eq b) = c) cmp d) ==
97. The following flow chart represents which of the following loop?
Entry

A

False

Test Commands
Condition

a) while do..done b)EﬁtntiI do..done c) do while done d) None of these
98. Which of the following statement is used to increment the value of ‘a’ by 1?

a) a++ b) a=expr $a + 1 c)a=%a + 1 d) a="expr $a + 1
99. While using case structure, the condition is checked and statements executed till is

found. —

a);; b) break c) break; d):
100. How is else statement/condition given in case structure?

a) else) b) esle) c) case else) d) )
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COMPUTER-III
What is the default size of the text displayed in a textbox in form?
a) 20 b) 25 c) 10 d) 15

What will be the output of the following: <input type=password size=20 maxlength=15>7?

a) total number of character that can be displayed is 15

b) total number of character that can be displayed is 20

c) total number of characters that can be displayed is between 15 and 20

d) All of the above are true

What will happen if you attempt entering more characters than the maximum size of characters
specified for an input type?

a) Beeping sound b) Over striking the last character

c) Both (a) or (b) depending on browser d) None of these

To avoid which type of error is the user asked to re-enter his/her password?

a) cryptographic b) typographic c) cerographic d) chirographic
Which of the following appears as two controls but is actually one control on the form?

a) <input type=file> b) <input type=password>

c¢) <input type=button> d) None of these

Which of the following <input> takes the form of a circular inset?

a) radio button b) check box c¢) drop down menu d) password

Which of the following does not need <input> element?

a) radio button b) check box c) drop down menu  d) textbox

Which of the following is not an attribute of <option>?

a) selected b) multiple c) value d) All of these

Which of the following event will occur as soon as the object has finished loading into the browser?
a) onmouseload b) onformload ¢) onload d) None of these
Which of the following event will occur when the element loses focus of the element?

a) onblur b) onfocus c¢) onlostfocus d) None of these
Which of the following is an property of textbox in JavaScript?

a) value b) text c) length d) All of these

Which of the following is not a built-in function in JavaScript?

a) parselnt b) changeBkgrnd c) parseFloat d) None of these
Which of the following is correct for the variable ‘ab’ in JavaScript?

a) ab=15; b) var ab; ab=15; c) var ab=15; d) All of these

Which of the following is the correct way of writing your class on the webpage using JavaScript?
a) document.write(12) b) document.writeln(12)

c) document.write(“12”) d) All of these

What error appears if while using parseFloat( ) the first character cannot be converted to a number?
a) NaN b) Undefined c) Null d) Invalid

Which of the following event handler is used to activate a code when the object is clicked twice?
a) dbclick b) ondbclick c) ondblclick d) ondoubleclick
Which type of image file format is not supported by all browsers?

a) PNG b) JPG c) BMP d) None of these

IIS stands for :

a) Internet Information Services b) International Information Services

c) Indian Internet Services d) Idea International Services

Which site should you log on, to verify the uniqueness of the domain name selected for your
website?

a) http://whois.domainname.com b) http://whois.domainreqistry.com

c) http://nswhois.domainregistry.com d) http://nswhois.domainname.com

The charges paid annually for the domain name would vary with which of the following issues?
a) mail facility b) server type c) size of space d) All of these

What is the storing of web site on a disk of server computer on Internet running the web server
software called?

a) Publishing b) Web Hosting ¢) Updating d) Both (a) & (b)
What is meant by domain registration?

a) Creating a website b) Getting a web space

c) Getting a unique name for website d) Uploading the web site

Which of the following allows domain registration?

a) ISP b) 1IS c) WSFTP d) All of these

Which of the following options should be followed to add a new web page to your website while
using Publisher?

a) Edit>Page b) Insert>Page c¢) Tools>Add—>Page d) Insert>New—->Page
Which of the following option is selected to display a list on the webpage using Publisher?
a) General Information b) List c) General List d) None of these

Which option is used to view the webpage as it is being designed in Publisher?

a) File>Web page Preview b) View >Web page c) Window—>Preview d) File>Preview
What should be the name of the main file of the website while hosting a website?

a) index.htm b) home.htm ¢) main.htm d) All of these
Which of the following provide services which connect the online payment parties to perform
authorization and payments in a secured manner?
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a) EDI Gateways b) Payment Gatewaysc) Online Gateways d) ABC Gateways
Which of the following are the data centers that perform the credit card transactions and settle funds
to the merchant?

a) Payment b) EDI c) Processors d) Both (a) & (b)
The bank that provides credit card facility to the customer is called .

a) issuing bank b) online bank ¢) acquiring bank d) merchant bank
Which of the following is an example of electronic cash?

a) credit card b) eCash c) debit card d) smart card
Display of which logo indicates that the communication on the logged on site is secured?
a) SSL b) VeriSign c) SecureSign d) VeriSecure
SSL stands for .

a) Secure Signature Layer b) Secure Socket Link

c) Secure Socket Layer d) Secure Signature Link

Which of the following is true for a secured e-commerce website?

a) web-address begins with ftp b) web-address begins with http

c) web-address begins with shttp d) web-address begins with https
What is a catalogue on an e-commerce website?

a) customers’ list enrolled on the website b) List of items sold on the website

c) services list provided on the website d) Links to related websites

Which of the following are server side scripting languages?

a) VB Script b) Hypertext Preprocessor

c) Jscript d) All of these

How do you save your website in HTML format using Publisher?

a) File >Save b) File > Export > Webpage

c) File > Web Page - Save d) File >Save As->Webpage

How is a textbox added to the webpage in Publisher?

a) Insert->Textbox b) Add-> Textbox c) Tools>Textbox  d) Insert->Drawing
Which menu allows you to create a hyperlink in Publisher?

a) Edit b) Add c) Insert d) Tools

Which of the following is not very important while purchasing on an e-commerce website?
a) Selecting payment terms b) Name c) Contact Address  d) All of these
Apache HTTP Server can be downloaded from which of the following website?

a) http://http.apache.org b) http://https.apache.org

c) http://httpd.apache.org d) http://http.apache.com

What is Apache Tomcat?

a) web server b) database c) office suite d) web browser
Using which of the following open office software can a mathematical equation be created?
a) Draw b) Math c) Open Math d) Mathematica
Open Office Base uses its own built-in database engine.

a) SQL b) PL/SQL c) HSQL d) MySQL
Which of the following OS can be downloaded free from the net?

a) MINIX b) Lynx c) Lotus d) Flock

Firefox can work on which of the following OS?

a) Mac OS b) Linux c) Both (a) & (b) d) None of these
Which of the following make short work of flowcharts and organization charts?

a) Smart connectors b) Line ¢) Autoshapes d) Rendering
Which option allows changing the setting of the mouse in Linux?

a) System Settings b) System Tools c) Settings d) Preferences
What is the Recycle Bin called in Linux?

a) Bin b) Recycler c) Trash d) Recycle Bin

Which of the following is an important configuration file whose backup saves re-configuration on re-
installation of Linux?

a) etc.conf b) grub.conf c) lilo.conf d) hda1.conf

Any device in Linux needs to be attached to some existing directory. What is this existing directory
called?

a) mounting b) mount point c¢) device point d) /dev point
Which type of hierarchical directory structure does Linux follow?

a) Single b) Dual c) Multiple d) Bus
Which of the following shows the various partitions on the first master drive of the Linux system?
a) letc b) /dev c) /mnt d) /dir
Which of the following directory is used for recovering Linux from any crash situation?
a) /lost+found b) /boot c) ltmp d) /proc

Use of which shortcut key allows changes in the text style in Notes view in Impress?
a) F6 b) F10 c) F11 d) F12

How many prepackaged Master Pages are available in Impress?

a)4 b) 5 c) 6 d) 10

You have already selected a master slide. Now you want to make changes in this master slide.
Which of the options will allow you to do so?

a) View >Master Slide b) Tools>Master->Master slide

c) Format->Master slide d) View—>Master->Master Slide
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58. Which of the following is an incorrect option in background styles of slides in Impress?

a) None b) Gradient c) Pattern d) Bitmap
59. Which icon on the drawing toolbar allows rotation of an object/drawing in Draw?
a) Freerotate b) Rotation c) Effect d) Tilt
60. What is the shortcut key to save a writer file?
a)Ctrl + S b) Ctrl + Shift + S c)Ctrl + Alt + S d) Shift + Alt + S
61. Which of the following displays all the objects contained in writer document?
a) Clipboard b) Navigator c¢) Toolbox d) Custom Toolkit
62. Writer tries to guess which word you are typing and offers to complete the word for you, this feature
is called?
a) Autocorrect b) AutoFormat c) Word Completion d) AutoCompletion
63. How many slide transition effects are available in Impress?
a) 54 b) 56 c) 52 d) 58
64. While modifying the background styles in Impress slide, Background style->None indicates that all
the slides shall have color.
a) grey b) black c¢) hatched d) white
65. Under which category does the ‘pmt’ function appear in Calc?
a) Add Ins b) Database c) Financial d) Statistical
66. On creating a table using Wizard in Base, which step allows changing the Field Type (type of data
entered) ?
a) Select fields b) Set Types and Formats
c) Set primary key d) None of these
67. The control can be arranged in different ways while creating a form through wizard in
Base.
a)4 b) 5 c)6 d)8

68. A query to search for data where salary is greater than 10000, which of the following would be the
correct way to get the output in Design Query?

a) Criterion:>10000 b) Criterion:’>10000’ c) Criterion:’is>10000’d) All of these
69. Which type of reports can be generated in Base?
a) Editable b) Summary c) Dynamic d) All of these
70. The total number of individual cells in a Calc sheet is .
a) 65536 b) 16217776 c) 1677216 d) 16777216
71. Which of the following is the correct way of entering validation to the datasheet in Calc?
a) Tools|Validation b) Data|Validity c) Tools|Validity d) Data|Validation
72. What is the default value stored in ‘ibase’?
a) 10 b) 2 c)8 d) 16
73. Which of the following command(s) will give which user are you logged in as on the system?
a) who b) who amii c) SLOGNAME d) All of these
74. What does the system variable ‘SHOME’ give?
a) Default shell b) Current user c) Default user d) Default directory
75. Which of the following command stands for parent directory?
a) .. b) . c)cd .. d)cd.
76. Which of the following command can be used to create multiple directories?
a) muldir b) dirmul c) mkdir d) mkdir -m
77. What will be the output of the following command where seta, setb and setc are filenames: cat seta
setc>setb?
a) seta, setb contents are appended to setc b) seta, setc contents are appended to setb

c) seta, setc contents are joined & placed in setb  d) Only setc data is copied to setb
78. What should an Oracle file have an extension when compiled in Linux?

a) .sql b) .ora c) .bas d) .dsql
79. Which of the following is usually not used in a filename in Linux?

a)/ b) . c) - d) All of these
80. What does the command Is *a do?

a) Gives list of files beginning with ‘a’ b) Gives the list of files beginning with a

c) Gives list of files ending with ‘a’ d) Gives the list of files ending with *’
81. How many files will be uncompressed with the following command: gzip —d a.gz b.gz c.gz?

a) first file only b) first & second file c) all three files d) None of them
82. Which command displays the file contents from the 7" record onwards of the file ‘buddy’?

a) tail +7 buddy b) tail -7 buddy c¢) head +7 buddy d) head -7 buddy
83. Which of the following is a valid option used with cut command?

a)—c b) -t c) -k d) None of these
84. Which of the following is a valid option used with sort command?

a)—d b) —r c) —f d) All of these

85. You have created a file in all uppercase. You now want to convert it to lowercase. Which of the
following Linux command will help you do so?

a)ts b) grep c) conv d) tr
86. Which of the following command can be used as a filter on files?

a) cut b) grep c) head d) All of these
87. Which command is used to join two same lined files laterally?

a) sort b) paste C) grep d) cat
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88. Which command is used to delete letters in vi editor after pressing Esc?

a) del b) R C) X d) All of these
89. Which command is used to delete an entire line in vi editor after pressing Esc?

a) del b) dd c)d d) All of these
90. Which symbol indicates the beginning of a comment line in vi editor?

a)$ b) # c)! d) &
91. Which of the following is used as an assignment operator in vi editor?

a) == b) —eq c):= d) =

92. When you place an arithmetic expression to be evaluated in brackets in vi editor, which of the
following symbol should precede the brackets?

a)* b)/ c)\ d) None of these
93. Which of the following is/are valid variable names in shell scripting?

a) _bdate b) x66 c)ci2_c d) All of these
94. Script commands beginning with which of the following symbol are not executed?

a)ll b) # c)/ d)/*

95. The command for executing the script final.sh, the command sh final.sh 23 -90 0 is entered. How
will -90 be shown in the script?

a)-90 b) $1 c) $3 d) $2

96. Which of the following is used to check the true condition if the length of the string is zero?
a)—-n b) -z c) +n d) +z

97. Which of the following indicates logical ‘OR’ condition?
a) or b) —or c) | d) -o

98. Which of the following indicates logical ‘NOT’ condition?
a) NOT b) ! c)!l d) -n

99. Which of the following is used to check non-equality of numbers?
a) —eq b) -nq C) -ne d)!=

100. Which of the following is used to check whether the file ‘strong’ exists or not?
a) —s strong b) —w strong c) —e strong d) —f strong
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